# SAFETY PRECAUTIONS

(Read these precautions before using this product.)

Before using this product, please read this manual and the relevant manuals carefully and pay full attention to safety to handle the product correctly.

The precautions given in this manual are concerned with this product only. For the safety precautions for the programmable controller system, refer to MELSEC iQ-R Module Configuration Manual.

In this manual, the safety precautions are classified into two levels: "⚠️ WARNING" and "⚠️ CAUTION".

| ⚠️ WARNING | Indicates that incorrect handling may cause hazardous conditions, resulting in death or severe injury. |
| ⚠️ CAUTION | Indicates that incorrect handling may cause hazardous conditions, resulting in minor or moderate injury or property damage. |

Under some circumstances, failure to observe the precautions given under "⚠️ CAUTION" may lead to serious consequences.

Observe the precautions of both levels because they are important for personal and system safety.

Make sure that the end users read this manual and then keep the manual in a safe place for future reference.
[Design Precautions]

\textbf{WARNING}

- Configure safety circuits external to the programmable controller to ensure that the entire system operates safely even when a fault occurs in the external power supply or the programmable controller. Failure to do so may result in an accident due to an incorrect output or malfunction.

1. Emergency stop circuits, protection circuits, and protective interlock circuits for conflicting operations (such as forward/reverse rotations or upper/lower limit positioning) must be configured external to the programmable controller.

2. When the programmable controller detects an abnormal condition, it stops the operation and all outputs are:
   - Turned off if the overcurrent or overvoltage protection of the power supply module is activated.
   - Held or turned off according to the parameter setting if the self-diagnostic function of the CPU module detects an error such as a watchdog timer error.

3. All outputs may be turned on if an error occurs in a part, such as an I/O control part, where the CPU module cannot detect any error. To ensure safety operation in such a case, provide a safety mechanism or a fail-safe circuit external to the programmable controller. For a fail-safe circuit example, refer to "General Safety Requirements" in the MELSEC iQ-R Module Configuration Manual.

4. Outputs may remain on or off due to a failure of a component such as a relay and transistor in an output circuit. Configure an external circuit for monitoring output signals that could cause a serious accident.

- In an output circuit, when a load current exceeding the rated current or an overcurrent caused by a load short-circuit flows for a long time, it may cause smoke and fire. To prevent this, configure an external safety circuit, such as a fuse.

- Configure a circuit so that the programmable controller is turned on first and then the external power supply. If the external power supply is turned on first, an accident may occur due to an incorrect output or malfunction.

- For the operating status of each station after a communication failure, refer to manuals relevant to the network. Incorrect output or malfunction due to a communication failure may result in an accident.

- When connecting an external device with a CPU module or intelligent function module to modify data of a running programmable controller, configure an interlock circuit in the program to ensure that the entire system will always operate safely. For other forms of control (such as program modification, parameter change, forced output, or operating status change) of a running programmable controller, read the relevant manuals carefully and ensure that the operation is safe before proceeding. Improper operation may damage machines or cause accidents.

- Especially, when a remote programmable controller is controlled by an external device, immediate action cannot be taken if a problem occurs in the programmable controller due to a communication failure. To prevent this, configure an interlock circuit in the program, and determine corrective actions to be taken between the external device and CPU module in case of a communication failure.
[Design Precautions]

**WARNING**

- Do not write any data to the "system area" and "write-protect area" of the buffer memory in the module. Also, do not use any "use prohibited" signals as an output signal from the CPU module to each module. Doing so may cause malfunction of the programmable controller system. For the "system area", "write-protect area", and the "use prohibited" signals, refer to the user's manual for the module used.

- If a communication cable is disconnected, the network may be unstable, resulting in a communication failure of multiple stations. Configure an interlock circuit in the program to ensure that the entire system will always operate safely even if communications fail. Incorrect output or malfunction due to a communication failure may result in an accident.

[Design Precautions]

**CAUTION**

- Do not install the control lines or communication cables together with the main circuit lines or power cables. Keep a distance of 100 mm or more between them. Failure to do so may result in malfunction due to noise.

- During control of an inductive load such as a lamp, heater, or solenoid valve, a large current (approximately ten times greater than normal) may flow when the output is turned from off to on. Therefore, use a module that has a sufficient current rating.

- After the CPU module is powered on or is reset, the time taken to enter the RUN status varies depending on the system configuration, parameter settings, and/or program size. Design circuits so that the entire system will always operate safely, regardless of the time.

- Do not power off the programmable controller or do not reset the CPU module while the settings are being written. Doing so will make the data in the flash ROM or SD memory card undefined. The values need to be set in the buffer memory and written to the flash ROM or the SD memory card again. Doing so may cause malfunction or failure of the module.

- When changing the operating status of the CPU module from external devices (such as the remote RUN/STOP functions), select "Do Not OPEN in Program" for "Open Method Setting" of "Module Parameter". If "OPEN in Program" is selected, an execution of the remote STOP function causes the communication line to close. Consequently, the CPU module cannot reopen the line, and external devices cannot execute the remote RUN function.

[Security Precautions]

**WARNING**

- To maintain the security (confidentiality, integrity, and availability) of the programmable controller and the system against unauthorized access, denial-of-service (DoS) attacks, computer viruses, and other cyberattacks from external devices via the network, take appropriate measures such as firewalls, virtual private networks (VPNs), and antivirus solutions.
[Installation Precautions]

⚠️ WARNING

● Shut off the external power supply (all phases) used in the system before mounting or removing the module. Failure to do so may result in electric shock or cause the module to fail or malfunction.

[Installation Precautions]

⚠️ CAUTION

● Use the programmable controller in an environment that meets general specifications written in Safety Guidelines included in the base unit. Failure to do so may result in electric shock, fire, malfunction, or damage to or deterioration of the product.

● To mount a module, place the concave part(s) located at the bottom onto the guide(s) of the base unit, and push in the module, and make sure to fix the module with screws since this module has no module fixing hook. Incorrect interconnection may cause malfunction, failure, or drop of the module.

● Tighten the screws within the specified torque range. Undertightening can cause drop of the screw, short circuit, or malfunction. Overtightening can damage the screw and/or module, resulting in drop, short circuit, or malfunction.

● When using an extension cable, connect it to the extension cable connector of the base unit securely. Check the connection for looseness. Poor contact may cause malfunction.

● When using an SD memory card, fully insert it into the memory card slot. Check that it is inserted completely. Poor contact may cause malfunction.

● Securely insert an extended SRAM cassette or a battery-less option cassette into the cassette connector of the CPU module. After insertion, close the cassette cover and check that the cassette is inserted completely. Poor contact may cause malfunction.

● Do not directly touch any conductive parts and electronic components of the module, SD memory card, extended SRAM cassette, battery-less option cassette, or connector. Doing so can cause malfunction or failure of the module.

[Wiring Precautions]

⚠️ WARNING

● Shut off the external power supply (all phases) used in the system before installation and wiring. Failure to do so may result in electric shock or cause the module to fail or malfunction.

● After installation and wiring, attach the included terminal cover to the module before turning it on for operation. Failure to do so may result in electric shock.
[Wiring Precautions]

⚠️ CAUTION

- Individually ground the FG and LG terminals of the programmable controller with a ground resistance of 100 ohms or less. Failure to do so may result in electric shock or malfunction.
- Use applicable solderless terminals and tighten them within the specified torque range. If any spade solderless terminal is used, it may be disconnected when the terminal screw comes loose, resulting in failure.
- Check the rated voltage and signal layout before wiring to the module, and connect the cables correctly. Connecting a power supply with a different voltage rating or incorrect wiring may cause fire or failure.
- Connectors for external devices must be crimped or pressed with the tool specified by the manufacturer, or must be correctly soldered. Incomplete connections may cause short circuit, fire, or malfunction.
- Securely connect the connector to the module. Poor contact may cause malfunction.
- Do not install the control lines or communication cables together with the main circuit lines or power cables. Keep a distance of 100 mm or more between them. Failure to do so may result in malfunction due to noise.
- Place the cables in a duct or clamp them. If not, dangling cables may swing or inadvertently be pulled, resulting in malfunction or damage to modules or cables. In addition, the weight of the cables may put stress on modules in an environment of strong vibrations and shocks. Do not clamp the extension cables with the jacket stripped. Doing so may change the characteristics of the cables, resulting in malfunction.
- Check the interface type and correctly connect the cable. Incorrect wiring (connecting the cable to an incorrect interface) may cause failure of the module and external device.
- Tighten the terminal screws or connector screws within the specified torque range. Undertightening can cause drop of the screw, short circuit, fire, or malfunction. Overtightening can damage the screw and/or module, resulting in drop, short circuit, fire, or malfunction.
- When disconnecting the cable from the module, do not pull the cable by the cable part. For the cable with connector, hold the connector part of the cable. For the cable connected to the terminal block, loosen the terminal screw. Pulling the cable connected to the module may result in malfunction or damage to the module or cable.
- Prevent foreign matter such as dust or wire chips from entering the module. Such foreign matter can cause a fire, failure, or malfunction.
- A protective film is attached to the top of the module to prevent foreign matter, such as wire chips, from entering the module during wiring. Do not remove the film during wiring. Remove it for heat dissipation before system operation.
[Wiring Precautions]

⚠️ CAUTION

- Programmable controllers must be installed in control panels. Connect the main power supply to the power supply module in the control panel through a relay terminal block. Wiring and replacement of a power supply module must be performed by qualified maintenance personnel with knowledge of protection against electric shock. For wiring, refer to the MELSEC iQ-R Module Configuration Manual.
- For Ethernet cables to be used in the system, select the ones that meet the specifications in the user’s manual for the module used. If not, normal data transmission is not guaranteed.

[Startup and Maintenance Precautions]

⚠️ WARNING

- Do not touch any terminal while power is on. Doing so will cause electric shock or malfunction.
- Correctly connect the battery connector. Do not charge, disassemble, heat, short-circuit, solder, or throw the battery into the fire. Also, do not expose it to liquid or strong shock. Doing so will cause the battery to produce heat, explode, ignite, or leak, resulting in injury or fire.
- Shut off the external power supply (all phases) used in the system before cleaning the module or retightening the terminal screws, connector screws, or module fixing screws. Failure to do so may result in electric shock.
[Startup and Maintenance Precautions]

**CAUTION**

- When connecting an external device with a CPU module or intelligent function module to modify data of a running programmable controller, configure an interlock circuit in the program to ensure that the entire system will always operate safely. For other forms of control (such as program modification, parameter change, forced output, or operating status change) of a running programmable controller, read the relevant manuals carefully and ensure that the operation is safe before proceeding. Improper operation may damage machines or cause accidents.
- Especially, when a remote programmable controller is controlled by an external device, immediate action cannot be taken if a problem occurs in the programmable controller due to a communication failure. To prevent this, configure an interlock circuit in the program, and determine corrective actions to be taken between the external device and CPU module in case of a communication failure.
- Do not disassemble or modify the modules. Doing so may cause failure, malfunction, injury, or a fire.
- Use any radio communication device such as a cellular phone or PHS (Personal Handy-phone System) more than 25cm away in all directions from the programmable controller. Failure to do so may cause malfunction.
- Shut off the external power supply (all phases) used in the system before mounting or removing the module. Failure to do so may cause the module to fail or malfunction.
- Tighten the screws within the specified torque range. Undertightening can cause drop of the component or wire, short circuit, or malfunction. Overtightening can damage the screw and/or module, resulting in drop, short circuit, or malfunction.
- After the first use of the product, do not perform each of the following operations more than 50 times (IEC 61131-2/JIS B 3502 compliant). Exceeding the limit may cause malfunction.
  - Mounting/removing the module to/from the base unit
  - Inserting/removing the extended SRAM cassette or battery-less option cassette to/from the CPU module
  - Mounting/removing the terminal block to/from the module
- After the first use of the product, do not insert/remove the SD memory card to/from the CPU module more than 500 times. Exceeding the limit may cause malfunction.
- Do not touch the metal terminals on the back side of the SD memory card. Doing so may cause malfunction or failure of the module.
- Do not touch the integrated circuits on the circuit board of an extended SRAM cassette or a battery-less option cassette. Doing so may cause malfunction or failure of the module.
- Do not drop or apply shock to the battery to be installed in the module. Doing so may damage the battery, causing the battery fluid to leak inside the battery. If the battery is dropped or any shock is applied to it, dispose of it without using.
- Startup and maintenance of a control panel must be performed by qualified maintenance personnel with knowledge of protection against electric shock. Lock the control panel so that only qualified maintenance personnel can operate it.
[Startup and Maintenance Precautions]

⚠️ CAUTION
● Before handling the module, touch a conducting object such as a grounded metal to discharge the static electricity from the human body. Failure to do so may cause the module to fail or malfunction.

[Operating Precautions]

⚠️ WARNING
● Ensure safety before controlling a running programmable controller (e.g. data modification).
● Do not write any data in the system area of the buffer memory in the intelligent function module. Also, do not use any "use prohibited" signals as an output signal from the CPU module to the intelligent function module. Doing so may cause malfunction of a programmable controller system.

[Operating Precautions]

⚠️ CAUTION
● When changing data and operating status, and modifying program of the running programmable controller from an external device such as a personal computer connected to an intelligent function module, read relevant manuals carefully and ensure the safety before operation. Incorrect change or modification may cause system malfunction, damage to the machines, or accidents.
● Do not power off the programmable controller or reset the CPU module while the setting values in the buffer memory are being written to the flash ROM in the module. Doing so will make the data in the flash ROM or SD memory card undefined. The values need to be set in the buffer memory and written to the flash ROM or SD memory card again. Doing so can cause malfunction or failure of the module.

[Disposal Precautions]

⚠️ CAUTION
● When disposing of this product, treat it as industrial waste.
● When disposing of batteries, separate them from other wastes according to the local regulations. For details on battery regulations in EU member states, refer to the MELSEC iQ-R Module Configuration Manual.

[Transportation Precautions]

⚠️ CAUTION
● When transporting lithium batteries, follow the transportation regulations. For details on the regulated models, refer to the MELSEC iQ-R Module Configuration Manual.
● The halogens (such as fluorine, chlorine, bromine, and iodine), which are contained in a fumigant used for disinfection and pest control of wood packaging materials, may cause failure of the product. Prevent the entry of fumigant residues into the product or consider other methods (such as heat treatment) instead of fumigation. The disinfection and pest control measures must be applied to unprocessed raw wood.
CONDITIONS OF USE FOR THE PRODUCT

(1) MELSEC programmable controller ("the PRODUCT") shall be used in conditions;
   i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious accident; and
   ii) where the backup and fail-safe function are systematically or automatically provided outside of the PRODUCT for the case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries. MITSUBISHI ELECTRIC SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY the PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI ELECTRIC USER'S, INSTRUCTION AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT. ("Prohibited Application")

Prohibited Applications include, but not limited to, the use of the PRODUCT in:
- Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the public could be affected if any problem or fault occurs in the PRODUCT.
- Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality assurance system is required by the Purchaser or End User.
- Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator, Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other applications where there is a significant risk of injury to the public or property.

Notwithstanding the above restrictions, Mitsubishi Electric may in its sole discretion, authorize use of the PRODUCT in one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the specific applications agreed to by Mitsubishi Electric and provided further that no special quality assurance or fail-safe, redundant or other safety features which exceed the general specifications of the PRODUCTs are required. For details, please contact the Mitsubishi Electric representative in your region.

(3) Mitsubishi Electric shall have no responsibility or liability for any problems involving programmable controller trouble and system trouble caused by DoS attacks, unauthorized access, computer viruses, and other cyberattacks.
INTRODUCTION

Thank you for purchasing the Mitsubishi Electric MELSEC iQ-R series programmable controllers. This manual describes the performance specifications, procedure before operation, wiring, and operation examples to use the module listed below.

Before using this product, please read this manual and the relevant manuals carefully and develop familiarity with the functions and performance of the MELSEC iQ-R series programmable controller to handle the product correctly. Please make sure that the end users read this manual.

Point

The program examples shown in this manual are the examples in which OPC UA server module (RD81OPC96) is assigned to the input/output No. X/Y0 to X/Y1F unless otherwise specified. To use the program examples shown in this manual, the input/output number assignment is required. For details on the assignment of input/output number, refer to the following manual.

MELSEC iQ-R Module Configuration Manual

Relevant product

RD81OPC96

COMPLIANCE WITH THE EMC AND LOW VOLTAGE DIRECTIVES

Method of ensuring compliance

To ensure that Mitsubishi programmable controllers maintain EMC and Low Voltage Directives when incorporated into other machinery or equipment, certain measures may be necessary. Please refer to one of the following manuals.

• MELSEC iQ-R Module Configuration Manual
• Safety Guidelines (included in a base unit)

The CE mark on the side of the programmable controller indicates compliance with EMC and Low Voltage Directives.

Additional measures

To ensure that this product maintains EMC and Low Voltage Directives, please refer to one of the following manuals.

• MELSEC iQ-R Module Configuration Manual
• Safety Guidelines (included in a base unit)
## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFETY PRECAUTIONS</td>
<td>1</td>
</tr>
<tr>
<td>CONDITIONS OF USE FOR THE PRODUCT</td>
<td>9</td>
</tr>
<tr>
<td>INTRODUCTION</td>
<td>10</td>
</tr>
<tr>
<td>COMPLIANCE WITH THE EMC AND LOW VOLTAGE DIRECTIVES</td>
<td>10</td>
</tr>
<tr>
<td>RELEVANT MANUALS</td>
<td>13</td>
</tr>
<tr>
<td>TERMS</td>
<td>14</td>
</tr>
<tr>
<td>GENERIC TERMS AND ABBREVIATIONS</td>
<td>14</td>
</tr>
</tbody>
</table>

### CHAPTER 1 PART NAMES

### CHAPTER 2 SPECIFICATIONS

#### 2.1 Performance Specifications
- Hardware specification........................................................................... 17
- Software specification............................................................................ 18

#### 2.2 Access Specifications for a CPU Module
- Accessible CPU modules........................................................................ 24
- Accessible routes.................................................................................. 25
- Accessible devices................................................................................. 30
- Bit specification/digit specification of devices.................................. 32
- Access units........................................................................................... 33

### CHAPTER 3 FUNCTION LIST

#### 3.1 OPC UA Server Module
#### 3.2 Configuration Tool

### CHAPTER 4 PROCEDURE BEFORE OPERATION

#### 4.1 Starting an OPC UA Server Module and a Configuration Personal Computer
#### 4.2 Configuration Tool
#### 4.3 Parameter Setting
#### 4.4 SD Memory Card
- Operation for inserting an SD memory card....................................... 44
- Operation for removing or replacing an SD memory card.......................... 44
- File access stop processing method.................................................. 45
- Insertion/removal method of an SD memory card.................................... 46
- Considerations for using an SD memory card....................................... 47

### CHAPTER 5 SYSTEM CONFIGURATION

#### 5.1 System Configuration
- Overall system configuration.............................................................. 48
- System configuration for the initial setup, maintenance, and inspection 48
- System configuration during operation................................................. 49

#### 5.2 Connection Device
#### 5.3 Operating Environment
#### 5.4 Supported Software Package

### CHAPTER 6 WIRING

#### 6.1 Wiring of an Ethernet Cable......................................................... 53
#### 6.2 Wiring Precautions......................................................................... 54
RELEVANT MANUALS

<table>
<thead>
<tr>
<th>Manual name [manual number]</th>
<th>Description</th>
<th>Available form</th>
</tr>
</thead>
<tbody>
<tr>
<td>MELSEC iQ-R OPC UA Server Module User’s Manual (Startup) [SH-081693ENG] (this manual)</td>
<td>Specifications, procedure before operation, wiring, and operation examples of an OPC UA server module</td>
<td>Print book e-Manual PDF</td>
</tr>
<tr>
<td>MELSEC iQ-R Module Configuration Manual [SH-081262ENG]</td>
<td>The combination of the MELSEC iQ-R series modules, common information on the installation/wiring in the system, and specifications of the power supply module, base unit, SD memory card, and battery</td>
<td>Print book e-Manual PDF</td>
</tr>
</tbody>
</table>

This manual does not include detailed information on the following:
• General specifications
• Applicable CPU modules and the number of mountable modules
• Applicable remote head modules and the number of mountable modules
• Installation

For details, refer to the following:
MELSEC iQ-R Module Configuration Manual

---

e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated tool.
e-Manual has the following features:
• Required information can be cross-searched in multiple manuals.
• Other manuals can be accessed from the links in the manual.
• Hardware specifications of each part can be found from the product figures.
• Pages that users often browse can be bookmarked.
• Sample programs can be copied to an engineering tool.
**TERMS**

Unless otherwise specified, this manual uses the following terms.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address space</td>
<td>Data that contains information of an access target device, a group, and a tag</td>
</tr>
<tr>
<td>Clamping</td>
<td>Controlling values in the range of set upper and lower limit values</td>
</tr>
<tr>
<td>Engineering tool</td>
<td>A tool used for setting up programmable controllers, programming, debugging, and maintenance. For the supported tools, refer to the following: MELSEC iQ-R Module Configuration Manual</td>
</tr>
</tbody>
</table>

For definitions of terms for safety CPUs, refer to the following: MELSEC iQ-R CPU Module User’s Manual (Application)

**GENERIC TERMS AND ABBREVIATIONS**

Unless otherwise specified, this manual uses the following generic terms and abbreviations.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration tool</td>
<td>MX OPC UA Module Configurator-R</td>
</tr>
<tr>
<td>LPCU</td>
<td>A MELSEC-L series CPU module</td>
</tr>
<tr>
<td>MC Works 64</td>
<td>Mitsubishi Electric SCADA software package</td>
</tr>
<tr>
<td>OPC</td>
<td>OLE for Process Control. An interoperability standard for the secure and reliable exchange of data in an industrial automation field and in other industries.</td>
</tr>
<tr>
<td>OPC UA</td>
<td>OPC Unified Architecture. Platform independent service-oriented architecture that integrates all the functionality of each OPC Classic specification into an extensible framework.</td>
</tr>
<tr>
<td>OPC UA server module</td>
<td>A MELSEC iQ-R OPC UA server module</td>
</tr>
<tr>
<td>QCPU (Q mode)</td>
<td>A MELSEC-Q series CPU module and MELSEC-Q series C Controller module</td>
</tr>
<tr>
<td>RCPU</td>
<td>A MELSEC iQ-R series CPU module and MELSEC iQ-R series C Controller module</td>
</tr>
<tr>
<td>SCADA</td>
<td>Supervisory Control And Data Acquisition An industrial control system for system monitoring and process control by using a computer.</td>
</tr>
<tr>
<td>Windows 8 or later</td>
<td>Windows 8, Windows 8.1, Windows 10</td>
</tr>
</tbody>
</table>
This chapter shows the part names of an OPC UA server module.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>RUN LED</td>
<td>Indicates the operating status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON: In operation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Flashing: In selection for online module change</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OFF: Watchdog timer error (hardware failure), module replacement allowed in the process of the online module change</td>
</tr>
<tr>
<td></td>
<td>ERR LED</td>
<td>Indicates the error status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON: Module continuation error or watchdog timer error (hardware failure)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Flashing: Module stop error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OFF: In normal status</td>
</tr>
<tr>
<td></td>
<td>OPR LED</td>
<td>Indicates the status of a module.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON: OPC UA server function performed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OFF: OPC UA server function stopped</td>
</tr>
<tr>
<td></td>
<td>CARD RDY LED</td>
<td>Indicates the accessibility of an SD memory card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON: Accessible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Flashing: Being prepared or formatted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OFF: Inaccessible (removable)</td>
</tr>
<tr>
<td></td>
<td>CARD ACS LED</td>
<td>Indicates the access status of an SD memory card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON: Being accessed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OFF: Not accessed</td>
</tr>
<tr>
<td>(2)</td>
<td>Dot matrix LED</td>
<td>Displays the contents of each display mode or the results of the self-diagnostic test.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The following contents are displayed in each display mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Error code: Displayed in four digits in hexadecimal (When multiple errors occur, only the latest error code is displayed.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IP address: Scrolled and displayed by 4 characters in decimal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For the display when performing the self-diagnostic test, refer to the following:</td>
</tr>
<tr>
<td></td>
<td>Slot cover</td>
<td>A cover of the SD memory card slot and the switches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open this cover to insert/remove an SD memory card or to operate the switches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close the cover unless inserting/removing an SD memory card or operating the switches to prevent foreign material intrusion such as dust.</td>
</tr>
<tr>
<td>(4)</td>
<td>SPEED LED</td>
<td>Indicates the communication speed and the link status for Ethernet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON (orange): Linking-up (1 Gbps)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON (green): Linking-up (100 Mbps)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OFF: Linking-down or linking-up (10 Mbps)</td>
</tr>
<tr>
<td>(5)</td>
<td>SD/RD LED</td>
<td>Indicates the data sending/receiving status in Ethernet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ON: Being sent/received</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OFF: Not being sent/received</td>
</tr>
</tbody>
</table>
### Ethernet port (CH1, CH2)\(^{1,2}\)
A port for connecting an OPC UA server module to 10BASE-T/100BASE-TX/1000BASE-T. (An OPC UA server module distinguishes among 10BASE-T, 100BASE-TX, and 1000BASE-T depending on an external device.)

### Dot matrix LED display mode switch (SELECT/MODE/SHOW switch)
A switch for switching the display of the dot matrix LED.
- **MODE**: To display the display mode name that is currently selected.
- **SELECT**: To select (switch) the display mode.
- **SHOW**: To display the contents of a selected display mode. (*Page 16 Dot matrix LED display*)

### SD memory card lock switch (SD CARD OFF button)
A switch for disabling access to an SD memory card to remove it. Removing an SD memory card is prohibited while the CARD RDY LED is ON or flashing. For the procedures for inserting and removing an SD memory card, refer to the following: (*Page 46 Insertion/removal method of an SD memory card*)

### Product information marking
Displays the product information (16 digits) of a module.

*1 Only CH1 can be connected to the configuration tool with direct connection.
*2 Only CH1 can be connected to OPC UA clients.

## Dot matrix LED display

The following table shows the contents of the display mode displayed on the dot matrix LED when switching the display mode to 'SHOW'.

<table>
<thead>
<tr>
<th>Display mode name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENo.</td>
<td>To display an error code.</td>
</tr>
<tr>
<td>IP1</td>
<td>To display the IP address of Ethernet port CH1.</td>
</tr>
<tr>
<td>IP2</td>
<td>To display the IP address of Ethernet port CH2.</td>
</tr>
</tbody>
</table>
This chapter explains the specifications of an OPC UA server module.

2.1 Performance Specifications

This section shows the performance specifications of an OPC UA server module.

Hardware specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD memory card slot</td>
<td>Interface SD memory card/SDHC memory card (2 GB to 16 GB)</td>
</tr>
<tr>
<td></td>
<td>Power supply +3.3 VDC, up to 200 mA</td>
</tr>
<tr>
<td>Ethernet port</td>
<td>Number of channels 2</td>
</tr>
<tr>
<td></td>
<td>Interface [1]</td>
</tr>
<tr>
<td></td>
<td>• 1000BASE-T</td>
</tr>
<tr>
<td></td>
<td>• 100BASE-TX</td>
</tr>
<tr>
<td></td>
<td>• 10BASE-T</td>
</tr>
<tr>
<td>Data transmission speed</td>
<td>1000BASE-T 1 Gbps</td>
</tr>
<tr>
<td></td>
<td>100BASE-TX 100 Mbps</td>
</tr>
<tr>
<td></td>
<td>10BASE-T 10 Mbps</td>
</tr>
<tr>
<td>Number of cascade connections [2] (When using a repeater hub)</td>
<td>1000BASE-T Consult the manufacturer of the repeater hub used.</td>
</tr>
<tr>
<td></td>
<td>100BASE-TX 2 levels maximum</td>
</tr>
<tr>
<td></td>
<td>10BASE-T 4 levels maximum</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Full-duplex/half-duplex</td>
</tr>
<tr>
<td>Transmission method</td>
<td>Base band</td>
</tr>
<tr>
<td>Maximum segment length [3]</td>
<td>100 m (length between a hub and a node)</td>
</tr>
<tr>
<td>Applicable connector for external wiring</td>
<td>RJ45</td>
</tr>
<tr>
<td>Supported function</td>
<td>• Auto-negotiation (automatic recognition of the communication speed/communication method)</td>
</tr>
<tr>
<td></td>
<td>• Auto-MDI/MDI-X (automatic recognition of a straight/crossing cable)</td>
</tr>
<tr>
<td>Number of occupied I/O points</td>
<td>32 points/slot (I/O assignment: Intelligent function module 32 points)</td>
</tr>
<tr>
<td>Clock</td>
<td>Acquired from a CPU module (CPU No.1 in a multiple CPU system).</td>
</tr>
<tr>
<td>5 VDC internal current consumption</td>
<td>1.25 A</td>
</tr>
<tr>
<td>External dimensions</td>
<td>Height 106 mm</td>
</tr>
<tr>
<td></td>
<td>Width 27.8 mm</td>
</tr>
<tr>
<td></td>
<td>Depth 110 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.25 kg</td>
</tr>
</tbody>
</table>

*1 1000BASE-T/100BASE-TX/10BASE-T, and full-duplex/half-duplex communication mode are identified by an OPC UA server module depending on the hub.
For connection with a hub not having the auto-negotiation function, set the setting on the hub side according to the communication mode.

*2 For a switching hub, consult the manufacturer of the hub used.

*3 For the maximum segment length (length between hubs), consult the manufacturer of the switching hub used.
**Software specification**

**OPC UA server specification**

An OPC UA server module supports Embedded UA Server Profile 1.03 provided by OPC Foundation.

<table>
<thead>
<tr>
<th>Item</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Space Model</td>
<td>Address Space Base</td>
</tr>
<tr>
<td>Base Information</td>
<td>Base Info Core Structure</td>
</tr>
<tr>
<td></td>
<td>Base Info Type System</td>
</tr>
<tr>
<td>Discovery Services</td>
<td>Discovery Get Endpoints</td>
</tr>
<tr>
<td></td>
<td>Discovery Find Servers Self</td>
</tr>
<tr>
<td>Session Services</td>
<td>Session General Service Behavior</td>
</tr>
<tr>
<td></td>
<td>Session Base</td>
</tr>
<tr>
<td></td>
<td>Session Minimum 1</td>
</tr>
<tr>
<td></td>
<td>Session Minimum 2 Parallel</td>
</tr>
<tr>
<td>View Services</td>
<td>View Basic</td>
</tr>
<tr>
<td></td>
<td>View TranslateBrowsePath</td>
</tr>
<tr>
<td></td>
<td>View RegisterNodes</td>
</tr>
<tr>
<td></td>
<td>View Minimum Continuation Point 01</td>
</tr>
<tr>
<td>Attribute Services</td>
<td>Attribute Read</td>
</tr>
<tr>
<td>Monitored Item Services</td>
<td>Monitor Basic</td>
</tr>
<tr>
<td></td>
<td>Monitor Value Change</td>
</tr>
<tr>
<td></td>
<td>Monitored Items Deadband Filter</td>
</tr>
<tr>
<td></td>
<td>Monitor Items 2</td>
</tr>
<tr>
<td></td>
<td>Monitor Items 10</td>
</tr>
<tr>
<td></td>
<td>Monitor Items 100</td>
</tr>
<tr>
<td></td>
<td>Monitor QueueSize_1</td>
</tr>
<tr>
<td></td>
<td>Monitor MinQueueSize_02</td>
</tr>
<tr>
<td></td>
<td>Monitor Triggering</td>
</tr>
<tr>
<td>Subscription Services</td>
<td>Subscription Basic</td>
</tr>
<tr>
<td></td>
<td>Subscription Minimum 1</td>
</tr>
<tr>
<td></td>
<td>Subscription Minimum 02</td>
</tr>
<tr>
<td></td>
<td>Subscription Publish Min 02</td>
</tr>
<tr>
<td></td>
<td>Subscription Publish Min 05</td>
</tr>
<tr>
<td></td>
<td>Subscription Publish Discard Policy</td>
</tr>
<tr>
<td>Protocol and Encoding</td>
<td>Protocol TCP Binary UA Security</td>
</tr>
<tr>
<td>Security</td>
<td>Security User Name Password</td>
</tr>
<tr>
<td></td>
<td>Security Certificate Validation</td>
</tr>
<tr>
<td></td>
<td>Security None</td>
</tr>
<tr>
<td></td>
<td>Security None CreateSession</td>
</tr>
<tr>
<td></td>
<td>Security Basic 128Rsa15</td>
</tr>
<tr>
<td></td>
<td>Security Encryption Required</td>
</tr>
<tr>
<td></td>
<td>Security Signing Required</td>
</tr>
<tr>
<td></td>
<td>Security Default Application</td>
</tr>
<tr>
<td></td>
<td>Security User X509</td>
</tr>
</tbody>
</table>
## Operation specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic operation specification</strong></td>
<td></td>
</tr>
<tr>
<td>Time information</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Acquired from a CPU module (CPU No.1 in a multiple CPU system).</td>
</tr>
<tr>
<td>Time zone</td>
<td></td>
</tr>
<tr>
<td><strong>Ethernet</strong></td>
<td></td>
</tr>
<tr>
<td>Connection method</td>
<td>IPv4</td>
</tr>
<tr>
<td><strong>Configuration tool</strong></td>
<td></td>
</tr>
<tr>
<td>Simultaneously connectable number</td>
<td>1</td>
</tr>
<tr>
<td>Connectable Ethernet port</td>
<td>• CH1</td>
</tr>
<tr>
<td></td>
<td>• CH2 (connection via a hub only)</td>
</tr>
<tr>
<td><strong>Device memory input/output</strong></td>
<td></td>
</tr>
<tr>
<td><strong>specification</strong></td>
<td></td>
</tr>
<tr>
<td>Group(^1)</td>
<td>Maximum number of definitions</td>
</tr>
<tr>
<td>Maximum number of layers</td>
<td>4</td>
</tr>
<tr>
<td><strong>Tag(^2)</strong></td>
<td></td>
</tr>
<tr>
<td>Maximum number of definitions</td>
<td>10000</td>
</tr>
<tr>
<td>Total word size of tags and structure labels</td>
<td>5120000 words</td>
</tr>
<tr>
<td>Maximum number of array elements/characters (firmware version ‘05’ or earlier)</td>
<td>128</td>
</tr>
<tr>
<td>Maximum number of array elements</td>
<td>Depends on each data type. (This also applies to the upper limit of the product of the number of elements in each dimension.)</td>
</tr>
<tr>
<td></td>
<td>• DINT, UDINT, TIME, REAL: 20480</td>
</tr>
<tr>
<td></td>
<td>• LREAL: 10240</td>
</tr>
<tr>
<td></td>
<td>• Structure: 5120</td>
</tr>
<tr>
<td></td>
<td>• STRING, WSTRING: Same as ‘maximum number of characters’</td>
</tr>
<tr>
<td></td>
<td>• Others: 40960</td>
</tr>
<tr>
<td>Maximum number of characters</td>
<td>255 characters</td>
</tr>
<tr>
<td><strong>Access target device</strong></td>
<td></td>
</tr>
<tr>
<td>Maximum number</td>
<td>8</td>
</tr>
<tr>
<td>Access target device type</td>
<td>• RCPU</td>
</tr>
<tr>
<td></td>
<td>• QCPU (Q mode)</td>
</tr>
<tr>
<td></td>
<td>• LCPU</td>
</tr>
<tr>
<td><strong>Polling</strong></td>
<td></td>
</tr>
<tr>
<td>Maximum number of definitions</td>
<td>8</td>
</tr>
<tr>
<td>Setting cycle</td>
<td>200 to 8640000 ms</td>
</tr>
<tr>
<td><strong>Conversion</strong></td>
<td></td>
</tr>
<tr>
<td>Maximum number of definitions</td>
<td>256</td>
</tr>
<tr>
<td><strong>Access data</strong></td>
<td></td>
</tr>
<tr>
<td>Data type</td>
<td></td>
</tr>
<tr>
<td>(^3)Page 21 Restrictions on the data type</td>
<td>• BOOL (logical type)</td>
</tr>
<tr>
<td></td>
<td>• INT (signed 16-bit integer type)</td>
</tr>
<tr>
<td></td>
<td>• UINT (unsigned 16-bit integer type)</td>
</tr>
<tr>
<td></td>
<td>• DINT (signed 32-bit integer type)</td>
</tr>
<tr>
<td></td>
<td>• UDINT (unsigned 32-bit integer type)</td>
</tr>
<tr>
<td></td>
<td>• TIME (time type)(^3)</td>
</tr>
<tr>
<td></td>
<td>• REAL (32-bit floating point type)</td>
</tr>
<tr>
<td></td>
<td>• LREAL (64-bit floating point type)</td>
</tr>
<tr>
<td></td>
<td>• ARRAY (one to three-dimensional array)(^4)</td>
</tr>
<tr>
<td></td>
<td>• STRING (ASCII string type)</td>
</tr>
<tr>
<td></td>
<td>• WSTRING (UTF-16 string type)</td>
</tr>
<tr>
<td><strong>Conversion specification</strong></td>
<td></td>
</tr>
<tr>
<td>Conversion</td>
<td></td>
</tr>
<tr>
<td>Conversion type</td>
<td>• None (Double type)</td>
</tr>
<tr>
<td></td>
<td>• Linear</td>
</tr>
<tr>
<td></td>
<td>• Square root</td>
</tr>
<tr>
<td><strong>Clamping</strong></td>
<td></td>
</tr>
<tr>
<td>Clamping type</td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Engineering unit</td>
</tr>
<tr>
<td></td>
<td>• Details (Another engineering unit can be specified.)</td>
</tr>
<tr>
<td><strong>Log output specification</strong></td>
<td></td>
</tr>
<tr>
<td>Log retention period</td>
<td>14 days</td>
</tr>
<tr>
<td>Maximum file size</td>
<td>99 MB</td>
</tr>
<tr>
<td>Required free space</td>
<td>100 MB or more</td>
</tr>
<tr>
<td><strong>Number specification of connected OPC UA clients</strong></td>
<td></td>
</tr>
<tr>
<td>Connection setting</td>
<td>Maximum number of connections</td>
</tr>
<tr>
<td>Connectable Ethernet port</td>
<td>CH1</td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Structure specification</td>
<td></td>
</tr>
<tr>
<td>Structure definition</td>
<td></td>
</tr>
<tr>
<td>Maximum number of settings</td>
<td>128</td>
</tr>
<tr>
<td>Maximum number of members that can be set for one structure</td>
<td>5120$^5$</td>
</tr>
<tr>
<td>Maximum number of array elements/characters (firmware version '05' or earlier)</td>
<td>Same as a corresponding item of 'tag'</td>
</tr>
<tr>
<td>Maximum number of array elements</td>
<td></td>
</tr>
<tr>
<td>Maximum number of characters</td>
<td></td>
</tr>
<tr>
<td>Maximum number of layers</td>
<td>5</td>
</tr>
<tr>
<td>Data type of a member</td>
<td></td>
</tr>
<tr>
<td>• BOOL</td>
<td></td>
</tr>
<tr>
<td>• INT</td>
<td></td>
</tr>
<tr>
<td>• UINT</td>
<td></td>
</tr>
<tr>
<td>• DINT</td>
<td></td>
</tr>
<tr>
<td>• DINT</td>
<td></td>
</tr>
<tr>
<td>• TIMEx$^3$</td>
<td></td>
</tr>
<tr>
<td>• REAL</td>
<td></td>
</tr>
<tr>
<td>• LREAL</td>
<td></td>
</tr>
<tr>
<td>• ARRAY$^4$</td>
<td></td>
</tr>
<tr>
<td>• STRING</td>
<td></td>
</tr>
<tr>
<td>• WSTRING</td>
<td></td>
</tr>
<tr>
<td>• STRUCT</td>
<td></td>
</tr>
<tr>
<td>Number specification of name characters</td>
<td></td>
</tr>
<tr>
<td>Total number of characters in a group, tag, and structure label and its members</td>
<td>4600000 characters</td>
</tr>
<tr>
<td>Total number of characters per structure label or structure definition</td>
<td>800 characters</td>
</tr>
<tr>
<td>Subscription specification</td>
<td></td>
</tr>
<tr>
<td>Number of subscriptions</td>
<td>10 per session</td>
</tr>
<tr>
<td>Number of monitored items</td>
<td></td>
</tr>
<tr>
<td>• 10000$^6$ items per subscription</td>
<td></td>
</tr>
<tr>
<td>• 12000 items per session</td>
<td></td>
</tr>
<tr>
<td>• Total of 12000 items for all sessions</td>
<td></td>
</tr>
<tr>
<td>Application certificate specification$^7$</td>
<td></td>
</tr>
<tr>
<td>Trust list</td>
<td>Maximum number</td>
</tr>
<tr>
<td>Revocation list</td>
<td>Maximum number</td>
</tr>
<tr>
<td>Denied certificate list</td>
<td>Maximum number</td>
</tr>
<tr>
<td>User certificate specification$^7$</td>
<td></td>
</tr>
<tr>
<td>Trust list</td>
<td>Maximum number</td>
</tr>
<tr>
<td>Revocation list</td>
<td>Maximum number</td>
</tr>
<tr>
<td>Denied certificate list</td>
<td>Maximum number</td>
</tr>
</tbody>
</table>

*1 When using a structure label, a structure (including structure type members) is treated as a group. For the calculation method for the number of groups, refer to the following: Page 21 Calculation method for a name character, tag, or group

*2 When using a structure label, a member of a structure is treated as a tag. For the calculation method for the number of tags, refer to the following: Page 21 Calculation method for a name character, tag, or group

*3 Treated as DINT.

*4 Neither STRING nor WSTRING can be specified for an element of an array. Neither bit nor digit specification can be used for a device of an array.

*5 For the firmware version '05' or earlier: 128

*6 For the firmware version '05' or earlier: 3000

*7 For the expiration date of a certificate, refer to the following: Page 23 Certificate expiration date
2.1 Performance Specifications

Restrictions on the data type
○: Available, ×: Not available

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
<th>Bit device</th>
<th>Digit-specified bit device</th>
<th>Word device</th>
<th>Bit-specified word device</th>
<th>Double-word device</th>
<th>Array</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>Logical type</td>
<td>○</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>INT</td>
<td>Signed 16-bit integer type</td>
<td>×</td>
<td>○ (K1 to K4)</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>UINT</td>
<td>Unsigned 16-bit integer type</td>
<td>×</td>
<td>○ (K1 to K4)</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>DINT</td>
<td>Signed 32-bit integer type</td>
<td>×</td>
<td>○ (K5 to K8)</td>
<td>×</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>UDINT</td>
<td>Unsigned 32-bit integer type</td>
<td>×</td>
<td>○ (K5 to K8)</td>
<td>×</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>TIME*1</td>
<td>Time type</td>
<td>×</td>
<td>○ (K5 to K8)</td>
<td>×</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>REAL</td>
<td>32-bit floating point type</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>LREAL</td>
<td>64-bit floating point type</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>STRING</td>
<td>ASCII string type</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>WSTRING</td>
<td>UTF-16 string type</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>×</td>
<td>×</td>
</tr>
</tbody>
</table>

*1 Can be set when using an OPC UA server module the firmware version of which is '06' or later.
*2 Neither bit nor digit specification can be used for a device of an array.

Calculation method for a name character, tag, or group

Total number of characters per structure label or structure definition

- Calculation method
  - The total number of characters is the sum of the following 1 to 4.
    1. Structure label name (or structure name): Name length
    2. Member name in each hierarchy: Name length
    3. Structure array element name: _D1_D2_D3*1
    4. Concatenation character between hierarchies: Period (.)

*1 D1, D2, and D3 indicate the number of elements in one, two, and three dimensions, respectively.

Definition example

<table>
<thead>
<tr>
<th>Target character string</th>
<th>Target number of characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dev000.Chair.Cells._0_0.Bolt</td>
<td>28 characters</td>
</tr>
<tr>
<td>Dev000.Chair.Cells._0_0.Nut</td>
<td>27 characters</td>
</tr>
<tr>
<td>Dev000.Chair.Cells._0_0.Washer</td>
<td>30 characters</td>
</tr>
<tr>
<td>Dev000.Desk.Cells._0_0.Bolt</td>
<td>27 characters</td>
</tr>
<tr>
<td>Dev000.Desk.Cells._0_0.Nut</td>
<td>26 characters</td>
</tr>
<tr>
<td>Dev000.Desk.Cells._0_0.Washer</td>
<td>29 characters</td>
</tr>
</tbody>
</table>

Example: Structure definition "Cell" with members "Bolt," "Nut," and "Washer" of data type INT
- Structure definition "ToolBox" with members "Cells" of a two-dimensional array (one dimension: 2, two dimensions: 3) of structure definition "Cell"
- Structure labels "Chair" and "Desk" of structure definition "ToolBox"
Number of tags
The following formula is used for calculation.

\[ T_i = N_i \times \left( \sum M_i + \sum T_{i+1} \right) \]

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
</table>
| \( T_i \) | Number of tags in hierarchy 'i' | • Top hierarchy (parent): \( i = 0 \)  
• Hierarchy immediately under the top hierarchy (child): \( i = 1 \)  
• Hierarchy under a child (grandchild): \( i = 2 \) |
| \( N_i \) | Number of array elements in hierarchy 'i' | • When hierarchy 'i' is a structure array: Number of elements  
• When there is no array in hierarchy 'i': 1 |
| \( \sum M_i \) | Total number of tags immediately under hierarchy 'i' | • For an array tag: Number of elements  
• For no array: 1 |
| \( \sum T_{i+1} \) | Total number of tags in a group under hierarchy 'i' | • \( \sum T_{i+1} \): Total number of tags in a group immediately under hierarchy 'i'  
It is calculated recursively as \( T_{i+1}, T_{i+2}, \text{etc.} \) if the hierarchical structure continues. |

Number of groups
The following formula is used for calculation.

\[ G_i = 1 + N_i \times (isArray + \sum G_{i+1}) \]

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
</table>
| \( G_i \) | Number of groups in hierarchy 'i' | • Top hierarchy (parent): \( i = 0 \)  
• Hierarchy immediately under the top hierarchy (child): \( i = 1 \)  
• Hierarchy under a child (grandchild): \( i = 2 \) |
| \( N_i \) | Number of structure array elements of a structure in hierarchy 'i' | • When hierarchy 'i' is a structure array: Number of elements  
• When there is no array in hierarchy 'i': 1 |
| isArray | Array valid flag | • When hierarchy 'i' is a structure array: 1  
• When there is no array in hierarchy 'i': 0 |
| \( \sum G_{i+1} \) | Total number of structures under hierarchy 'i' | • \( \sum G_{i+1} \): Total number of groups in a group immediately under hierarchy 'i'  
It is calculated recursively as \( G_{i+1}, G_{i+2}, \text{etc.} \) if the hierarchical structure continues. |

Calculation examples of the number of tags and groups
Calculation examples are as follows:

<table>
<thead>
<tr>
<th>Definition example</th>
<th>Calculation target</th>
<th>Hierarchy</th>
<th>Calculation example</th>
</tr>
</thead>
</table>
| ![](structure.png) | Number of tags (= 12) | \( T_0 \): Root  
\( T_1 \): StructA  
\( T_2 \): StructureB  
\( T_3 \): StructureC | \( T_0 = 2 \times (2 + 0) = 4 \)  
\( T_1 = 3 \times (0 + T_2) = 12 \)  
\( T_2 = 1 \times (0 + T_3) = 12 \)  
\( T_3 = 1 \times (0 + T_4) = 12 \) |
| ![](structure.png) | Number of groups (= 14) | \( G_0 \): StructA  
\( G_1 \): StructureB  
\( G_2 \): StructureC | \( G_0 = 1 + 2 \times (1 + 0) = 3 \)  
\( G_1 = 1 + 3 \times (1 + G_3) = 13 \)  
\( G_2 = 1 + 1 \times (0 + G_4) = 14 \)  
\( G_3 = 1 + 1 \times (0 + G_5) = 14 \) |
Certificate expiration date
A certificate has its own expiration date. If a certificate set for an OPC UA server or OPC UA client expires in OPC UA communication, the communication stops. To prevent this, it is required to periodically check the certificate expiration date and update it.

When using a server certificate generated by this product
A certificate is valid for five years.

The procedure for updating a certificate is as follows:
1. Delete a server certificate in the "Manage Application Certificate" screen of the configuration tool.
2. Stop the operation of an OPC UA server module by any of the following operations, then restart it.
   - Turning the power OFF and ON
   - [Online] → [Update setting of OPC UA Server Module]
   - [Online] → [Stop the OPC UA Server Module]/[Restart the OPC UA Server Module]
## 2.2 Access Specifications for a CPU Module

This section shows the access specifications for a CPU module.

### Accessible CPU modules

<table>
<thead>
<tr>
<th>Series</th>
<th>Model name</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCPU</td>
<td>R00CPU, R01CPU, R02CPU, R04CPU, R08CPU, R16CPU, R32CPU, R120CPU</td>
</tr>
<tr>
<td></td>
<td>R04ENCPU, R08ENCPU, R16ENCPU, R32ENCPU, R120ENCPU</td>
</tr>
<tr>
<td>RnCPU</td>
<td></td>
</tr>
<tr>
<td>RnENCPU</td>
<td></td>
</tr>
<tr>
<td>Process CPU</td>
<td>R08CP, R16PC, R32PC, R120PC</td>
</tr>
<tr>
<td>Safety CPU</td>
<td>R08SFCPU, R16SFCPU, R32SFCPU, R120SFCPU</td>
</tr>
<tr>
<td>C Controller module</td>
<td>R12CCPU-V</td>
</tr>
<tr>
<td>QCPU (Q mode)</td>
<td>Q00JCPU, Q00UJCPU, Q00CPU, Q00UCPU, Q01CPU, Q01UCPU, Q02CPU, Q02UCPU, Q03UCPU, Q03UDCPU, Q03UDECPU, Q03UDVCPU, Q04UDHCPU, Q04UDHCPU, Q04UDVCPU, Q06UDHCPU, Q06UDEHCPU, Q06UDVCPU, Q10UDHCPU, Q10UDEHCPU, Q12HCPU, Q13UDHCPU, Q13UDEHCPU, Q13UDVCPU, Q20UDHCPU, Q20UDEHCPU, Q20UDVCPU, Q25UDHCPU, Q25UDEHCPU, Q25UDVCPU, Q50UDEHCPU, Q100UDEHCPU</td>
</tr>
<tr>
<td>Programable controller CPU</td>
<td>Q02PHCPU, Q04UDPVCPU, Q06PHCPU, Q06UDPVCPU, Q12PHCPU, Q13UDPVCPU, Q25PHCPU, Q26UDPVCPU</td>
</tr>
<tr>
<td>Process CPU</td>
<td>Q24DHCAPPU-V, Q24DHCCPU-LS, Q24DHCCPU-VG, Q26DHCAPPU-LS</td>
</tr>
<tr>
<td>C Controller module</td>
<td>Q12DCCPU-V, Q24DHCAPPU-V, Q24DHCCPU-LS, Q24DHCCPU-VG, Q26DHCAPPU-LS</td>
</tr>
<tr>
<td>LPCU</td>
<td>L02SCPU, L02SCPU-P, L02CPU, L02CPU-P, L06CPU, L06CPU-P, L26CPU, L26CPU-P, L26CPU-BT, L26CPU-PBT</td>
</tr>
</tbody>
</table>

*1 Cannot be used as a relay station.
*2 Only a module with a serial number of which the first five digits are 12042 or higher can be accessed.

When using a multiple CPU system, refer to the following:
- MELSEC iQ-R Module Configuration Manual
Accessible routes

The following figure shows accessible routes from an OPC UA server module.

- Access route from an OPC UA server module
- Connection from an Ethernet port of an OPC UA server module
- Connection by specifying the network number and the station number of a target station
- Connection by specifying the start I/O No. of a module to be routed and the station number of a target station

<table>
<thead>
<tr>
<th>Accessible route</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Own station (control CPU, another CPU in a multiple CPU system)</td>
<td>Page 26 Own station (control CPU, another CPU in a multiple CPU system)</td>
</tr>
<tr>
<td>- Indicates the own station (control CPU, another CPU in a multiple CPU system).</td>
<td></td>
</tr>
<tr>
<td>(2) Another station via a single network</td>
<td>Page 27 Access via an Ethernet port of an OPC UA server module</td>
</tr>
<tr>
<td>- Access via an Ethernet port of an OPC UA server module</td>
<td></td>
</tr>
<tr>
<td>- Access by specifying the network number and the station number of a target station (CC-Link IE Controller Network module, CC-Link IE Field Network module, or Ethernet interface module)</td>
<td>Page 28 Access by specifying the network number and the station number of a target station</td>
</tr>
<tr>
<td>- Access by specifying the start I/O No. of a module to be routed and the station number of a target station (CC-Link module)</td>
<td>Page 28 Access by specifying the start I/O No. of a module to be routed and the station number of a target station</td>
</tr>
<tr>
<td>(3) Another station via a co-existence network</td>
<td>Page 29 Access by specifying the network number and the station number via another station on CC-Link</td>
</tr>
<tr>
<td>- Access from the station accessed in 1 by specifying the network number and the station number of a target station</td>
<td></td>
</tr>
<tr>
<td>- Access from the station accessed in 2 by specifying the start I/O No. of a module that is routed through and the station number of a target station</td>
<td>Page 29 Access from another station specified by the network number and the station number on CC-Link</td>
</tr>
</tbody>
</table>
**Own station (control CPU, another CPU in a multiple CPU system)**

The following table shows the accessibility to a CPU module of a station on which an OPC UA server module is mounted.

- ○: Accessible, —: No combination

<table>
<thead>
<tr>
<th>Access route</th>
<th>Access target device type (series)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RCPU</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU/Process CPU/Safety CPU</td>
</tr>
<tr>
<td>Control CPU</td>
<td>○</td>
</tr>
<tr>
<td>Another CPU in a multiple CPU system</td>
<td>○¹ (CPU No.1 to 4)</td>
</tr>
</tbody>
</table>

*¹ No combination with an RnENCPU.
Another station via a single network

Access via an Ethernet port of an OPC UA server module

A target device can be accessed via an Ethernet port of an OPC UA server module in the status where the target device is connected to a network.

For the communication destination from an Ethernet port of an OPC UA server module, an Ethernet interface module or a CPU module (Ethernet port) can be specified.

For accessing a target station, direct access and access via another system\(^*1\) are available.

\(^*1\) It is not available when the series of an access target device and a system to be routed differ.

(Example) Access is available when the series of a target device and a system to be routed are 'QCPU'.

\(\bigcirc\): Accessible, —: No combination

<table>
<thead>
<tr>
<th>Access route</th>
<th>Access target device type (series)</th>
<th>RCPU</th>
<th>QCPU (Q mode)</th>
<th>LCPU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Programmable controller CPU/Process CPU/ Safety CPU</td>
<td>C Controller module</td>
<td>Programmable controller CPU/Process CPU</td>
<td>C Controller module</td>
</tr>
<tr>
<td>Ethernet port of an OPC UA server module → Ethernet interface module</td>
<td>Direct</td>
<td>—</td>
<td>(\bigcirc) (CPU No. 1 to 4)</td>
<td>—</td>
</tr>
<tr>
<td>Via another system</td>
<td>CC-Link IE Controller Network</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CC-Link IE Field Network</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ethernet(^3)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet port of an OPC UA server module → CPU module (Ethernet port)</td>
<td>Direct</td>
<td>(\bigcirc) (CPU No. 1 to 4)</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Via another system</td>
<td>CC-Link IE Controller Network</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CC-Link IE Field Network</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ethernet(^3)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\(^2\) It can access to an RnENCPU only in a single CPU system.

\(^3\) It is also supported by a QCPU (Q mode) for which the MELSOFT connection extended setting was set.

\(^4\) To access an Ethernet port of Q12DCCPU-V (Basic mode) directly, MELSOFT connection must be allowed in the Q12DCCPU-V (Basic mode) setting.

For details on the setting, refer to the following:

- Controller Module User's Manual (Utility Operation, Programming)
## Access by specifying the network number and the station number of a target station

A target device can be accessed via a relay station when the target device is connected within eight networks from a station, on which an OPC UA server module is mounted, and can be identified by the network number and the station number (or CPU number).

- **Accessible**, —: No combination

<table>
<thead>
<tr>
<th>Access route</th>
<th>Access target device type (series)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RCPU</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU/ Process CPU/ Safety CPU</td>
</tr>
<tr>
<td></td>
<td>C Controller module</td>
</tr>
<tr>
<td></td>
<td>QCPU (Q mode)</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU/ Process CPU</td>
</tr>
<tr>
<td></td>
<td>C Controller module</td>
</tr>
<tr>
<td></td>
<td>LCPU</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU</td>
</tr>
<tr>
<td>CC-Link IE Controller Network</td>
<td>○*1 (CPU No.1 to 4)</td>
</tr>
<tr>
<td>CC-Link IE Field Network</td>
<td>○ (CPU No.1 to 4)</td>
</tr>
<tr>
<td>Ethernet<em>2</em>3</td>
<td>—</td>
</tr>
</tbody>
</table>

*1 It can access to an RnENCPU only in a single CPU system.

*2 It is also supported by a QCPU (Q mode) for which the MELSOFT connection extended setting was set.

*3 Only CH2 of an OPC UA server module is accessible for the Ethernet route.

## Access by specifying the start I/O number of a module to be routed and the station number of a target station

The following table shows the accessible routes to connect with a target device and a station on which an OPC UA server module is mounted directly.

- **Accessible**, —: No combination

<table>
<thead>
<tr>
<th>Access route</th>
<th>Access target device type (series)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RCPU</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU/ Process CPU/ Safety CPU</td>
</tr>
<tr>
<td></td>
<td>C Controller module</td>
</tr>
<tr>
<td></td>
<td>QCPU (Q mode)</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU/ Process CPU</td>
</tr>
<tr>
<td></td>
<td>C Controller module</td>
</tr>
<tr>
<td></td>
<td>LCPU</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU</td>
</tr>
<tr>
<td>CC-Link</td>
<td>○*1 (CPU No.1 to 4)</td>
</tr>
</tbody>
</table>

*1 It can access to an RnENCPU only in a single CPU system.
### Access by specifying the network number and the station number via another station on CC-Link

The following table shows the accessible route to a target station from a station, on which an OPC UA server module is mounted, by specifying the network number and the station number of the target station. In this route, another station on CC-Link is accessed first (first route), then the target station is accessed from there.

- **Accessible**: Accessible
- **—**: No combination

<table>
<thead>
<tr>
<th>First access route</th>
<th>Second access route (co-existence network)</th>
<th>Access target device type (series)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>RCPU</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programmable controller CPU/Process CPU/ Safety CPU</td>
</tr>
<tr>
<td>CC-Link</td>
<td>CC-Link IE Controller Network</td>
<td>○*1 (CPU No. 1 to 4)</td>
</tr>
<tr>
<td></td>
<td>CC-Link IE Field Network</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Ethernet*2</td>
<td>—</td>
</tr>
</tbody>
</table>

*1 It can access to an RnENCPU only in a single CPU system.
*2 It is also supported by the QCPU (Q mode) for which the MELSOFT connection extended setting was set.

### Access from another station specified by the network number and the station number on CC-Link

The following table shows the accessible route to a target station from a station, on which an OPC UA server module is mounted, by specifying the start I/O No. of a module that is routed through and the station number of the target station. In this route, another station on CC-Link is accessed first by specifying the network number and the station number (first route), then the target device is accessed from there.

- **Accessible**: Accessible
- **—**: No combination

<table>
<thead>
<tr>
<th>First access route</th>
<th>Second access route (co-existence network)</th>
<th>Access target device type (series)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>RCPU</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programmable controller CPU/Process CPU/ Safety CPU</td>
</tr>
<tr>
<td>CC-Link IE Controller Network</td>
<td>CC-Link</td>
<td>○*1 (CPU No. 1 to 4)</td>
</tr>
<tr>
<td>CC-Link IE Field Network</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Ethernet<em>2</em>3</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

*1 It can access to an RnENCPU only in a single CPU system.
*2 It is also supported by a QCPU (Q mode) for which the MELSOFT connection extended setting was set.
*3 Only CH2 of an OPC UA server module is accessible for the Ethernet route.
## Accessible devices

The following table shows the accessible devices.

- ○: Accessible, ×: Not accessible, -: No device

<table>
<thead>
<tr>
<th>Device name (device)</th>
<th>Access target device type (series)</th>
<th>RCPU (Programmable controller CPU/Process CPU/Safety CPU&lt;sup&gt;1&lt;/sup&gt;)</th>
<th>QCPU (Q mode) (Programmable controller CPU/Process CPU)</th>
<th>LCPU (C Controller) (Programmable controller CPU)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function input (FX)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Function output (FY)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Function register (FD)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Special relay (SM)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Special register (SD)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Input relay (X)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Output relay (Y)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Internal relay (M)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Latch relay (L)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Annunciator (F)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Edge relay (V)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Link relay (B)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Data register (D)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Link register (W)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Timer</td>
<td>Contact (TS)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Coil (TC)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Current value (T/TN)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Long timer</td>
<td>Contact (LTS)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Coil (LTC)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Current value (LTI/LTN)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Counter</td>
<td>Contact (CS)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Coil (CC)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Current value (C/CN)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Long counter</td>
<td>Contact (LCS)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Coil (LCC)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Current value (LC/LCN)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Retentive timer</td>
<td>Contact (STS, SS&lt;sup&gt;3&lt;/sup&gt;)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Coil (STC, SC&lt;sup&gt;3&lt;/sup&gt;)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Current value (ST/STN, ST/SN&lt;sup&gt;3&lt;/sup&gt;)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Long retentive timer</td>
<td>Contact (LSTS)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Coil (LSTC)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Current value (LST/LSTN)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Link special relay (SB)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Link special register (SW)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Step relay (S)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Index register (Z)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Long index register (LZ)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>File register (R)</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>(ZR)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

<sup>1</sup> Standard models only
<table>
<thead>
<tr>
<th>Device name (device)</th>
<th>Access target device type (series)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RCPU</td>
</tr>
<tr>
<td></td>
<td>QCPU (Q mode)</td>
</tr>
<tr>
<td></td>
<td>LCPU</td>
</tr>
<tr>
<td></td>
<td>Programmable controller CPU/Process CPU/ Safety CPU*1</td>
</tr>
<tr>
<td></td>
<td>C Controller module</td>
</tr>
<tr>
<td>Link direct device</td>
<td></td>
</tr>
<tr>
<td>Link input (Jn\X)</td>
<td>○</td>
</tr>
<tr>
<td>Link output (Jn\Y)</td>
<td>○</td>
</tr>
<tr>
<td>Link relay (Jn\B)</td>
<td>○</td>
</tr>
<tr>
<td>Link special relay (Jn\SB)</td>
<td>○</td>
</tr>
<tr>
<td>Link register (Jn\W)</td>
<td>○</td>
</tr>
<tr>
<td>Link special register (Jn\SW)</td>
<td>○</td>
</tr>
<tr>
<td>Module access device</td>
<td></td>
</tr>
<tr>
<td>Module access device/ Intelligent function module device (Un\G)</td>
<td>○</td>
</tr>
<tr>
<td>Multiple CPU shared device (U3En\G)</td>
<td>—</td>
</tr>
<tr>
<td>CPU buffer memory access device</td>
<td>CPU buffer memory access device (U3En\G)</td>
</tr>
<tr>
<td>CPU buffer memory access device (fixed cycle communication area) (U3En\HG)</td>
<td>○*4</td>
</tr>
<tr>
<td>Refresh data register (RD)</td>
<td>×</td>
</tr>
</tbody>
</table>

*1 Safety devices cannot be accessed.
*2 Q12DCCPU-V (Basic mode) has no device.
*3 A device name for QCPUs (Q mode) and LCPUs
*4 RnENCPUs and safety CPUs have no device.
### Bit specification/digit specification of devices

The following table shows the availability of bit specification and digit specification of each device. These are available when using an OPC UA server module the firmware version of which is '06' or later.

- ○: Available, ×: Not available

<table>
<thead>
<tr>
<th>Device (device name)</th>
<th>Bit specification</th>
<th>Digit specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special relay (SM)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Special register (SD)</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Input relay (X)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Output relay (Y)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Internal relay (M)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Latch relay (L)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Annunciator (F)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Edge relay (V)</td>
<td>×</td>
<td>○*1</td>
</tr>
<tr>
<td>Link relay (B)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Data register (D)</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Link register (W)</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Timer</td>
<td>Contact (TS)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Coil (TC)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Current value (T/TN)</td>
<td>×</td>
</tr>
<tr>
<td>Long timer</td>
<td>Contact (LTS)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Coil (LTC)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Current value (LT/LTN)</td>
<td>×</td>
</tr>
<tr>
<td>Counter</td>
<td>Contact (CS)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Coil (CC)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Current value (C/CN)</td>
<td>×</td>
</tr>
<tr>
<td>Long counter</td>
<td>Contact (LCS)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Coil (LCC)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Current value (LC/LCN)</td>
<td>×</td>
</tr>
<tr>
<td>Retentive timer</td>
<td>Contact (STS, SS*2)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Coil (STC, SC*2)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Current value (ST/STN, ST/SN*2)</td>
<td>×</td>
</tr>
<tr>
<td>Long retentive timer</td>
<td>Contact (LSTS)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Coil (LSTC)</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Current value (LST/LSTN)</td>
<td>×</td>
</tr>
<tr>
<td>Link special relay (SB)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Link special register (SW)</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Index register (Z)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>File register</td>
<td>(R)</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>(ZR)</td>
<td>○</td>
</tr>
<tr>
<td>Link direct device</td>
<td>Link input (Jn(X))</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Link output (Jn(Y))</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Link relay (Jn(B))</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Link special relay (Jn(SB))</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Link register (Jn(W))</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Link special register (Jn(SW))</td>
<td>○</td>
</tr>
<tr>
<td>Module access device</td>
<td>Module access device/intelligent function module device (UniG)</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Multiple CPU shared device (U3En/G)</td>
<td>○</td>
</tr>
<tr>
<td>CPU buffer memory access device</td>
<td>CPU buffer memory access device (U3En/G)</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>CPU buffer memory access device (fixed cycle communication area) (U3En/HG)</td>
<td>○</td>
</tr>
</tbody>
</table>

*1 Not available for RCPUs.
*2 A device name for QCPUs (Q mode) and LCPUs
Access units

The following table shows the number of accessible device points (access units) in one process (one scanning) when accessing the device memory in a CPU module.

The access units of a CPU module other than the following modules depend on the module type.

<table>
<thead>
<tr>
<th>Access target device type (series)</th>
<th>Device reading</th>
<th>Device writing</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCPU</td>
<td>118 points(^1)</td>
<td>78 points(^1)</td>
</tr>
<tr>
<td>78 points(^2)</td>
<td>38 points(^2)</td>
<td></td>
</tr>
<tr>
<td>Programmable controller CPU</td>
<td>58 points(^2)</td>
<td></td>
</tr>
<tr>
<td>Process CPU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Safety CPU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C Controller module</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\(^1\) Access from a device other than an Ethernet port of an OPC UA server module

\(^2\) Access via an Ethernet port of an OPC UA server module

Data inconsistency

When the number of accessed device points is equal to the access unit or less, device values in a same sequence scan are obtained and applied.

When the number of device points exceeds the access unit, device values may be obtained from multiple sequence scans and applied, which may cause data inconsistency.

When data inconsistency is a problem

Set the following when a sequence program and the data needs to be synchronized and data inconsistency is a problem.

- Set the number of device points accessed at the same time to the access unit or less.
# 3 FUNCTION LIST

This chapter shows the function lists of an OPC UA server module and the configuration tool. For details on the functions, refer to the following:

- MELSEC iQ-R OPC UA Server Module User's Manual (Application)

## 3.1 OPC UA Server Module

This section shows the function list of an OPC UA server module.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Access function</td>
<td>To access tags (devices of a CPU module such as one on the own station or on a network) and structure labels registered in the address space from an OPC UA client.</td>
</tr>
<tr>
<td>Conversion function</td>
<td>To convert device values in the engineering unit.</td>
</tr>
<tr>
<td>User authentication function</td>
<td>To prevent illegal access to an OPC UA server module by a user name and a password.</td>
</tr>
<tr>
<td>SD memory card format function</td>
<td>To format an SD memory card.</td>
</tr>
<tr>
<td>Online module change function</td>
<td>To replace a module with another without stopping a running system. For the procedure, refer to the following: MELSEC iQ-R Online Module Change Manual</td>
</tr>
<tr>
<td>Firmware update function</td>
<td>To update the firmware of an OPC UA server module. For details, refer to the following: MELSEC iQ-R Module Configuration Manual</td>
</tr>
<tr>
<td>Initialization function</td>
<td>To initialize a firmware update-prohibited password retained in an OPC UA server module.</td>
</tr>
<tr>
<td>Global label-related data update function</td>
<td>To update data related to global labels by communicating with a CPU module.</td>
</tr>
</tbody>
</table>

### 3.2 Configuration Tool

This section shows the function list of the configuration tool.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address space setting function</strong></td>
<td></td>
</tr>
<tr>
<td>Tree view</td>
<td>To display address space information and each definition in a tree.</td>
</tr>
<tr>
<td>List view</td>
<td>To display a child item of an item selected on the tree view in a list.</td>
</tr>
<tr>
<td><strong>Access target device communication setting</strong></td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td>To create a tag, and assign a device number and polling definition, etc.</td>
</tr>
<tr>
<td>Structure label</td>
<td>To create a structure label by using a structure definition. A structure can be used as a group, and a member of a structure as a tag.</td>
</tr>
<tr>
<td>Group</td>
<td>To manage tags by grouping and hierarchizing them.</td>
</tr>
<tr>
<td>Array</td>
<td>To use a tag as an array. Members of a structure and structure labels can also be used as arrays.</td>
</tr>
<tr>
<td>Structure</td>
<td>To manage the data structure of a set structure definition.</td>
</tr>
<tr>
<td><strong>Conversion setting function</strong></td>
<td>To set a conversion definition. A set definition is used for the address space setting.</td>
</tr>
<tr>
<td><strong>Polling definition setting function</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Structure definition setting function</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Global label and common device comment import function</strong></td>
<td>To import global labels and common device comments that are set in an engineering tool into a setting of an OPC UA server module.</td>
</tr>
<tr>
<td><strong>OPC UA server operation function</strong></td>
<td></td>
</tr>
<tr>
<td>Online</td>
<td>To perform the following operations on an OPC UA server module.</td>
</tr>
<tr>
<td>Certificate</td>
<td>To create and manage a certificate.</td>
</tr>
<tr>
<td><strong>Log view function</strong></td>
<td>To display a communication log with an OPC UA server module in the log view.</td>
</tr>
<tr>
<td><strong>Help function</strong></td>
<td>To open MELSEC iQ-R OPC UA Server Module User’s Manual.</td>
</tr>
<tr>
<td><strong>Version information</strong></td>
<td>To display the version information of the configuration tool.</td>
</tr>
<tr>
<td><strong>Management function</strong></td>
<td>To display and change the prohibition state of the firmware update set in an OPC UA server module.</td>
</tr>
</tbody>
</table>
4 PROCEDURE BEFORE OPERATION

This chapter shows the procedure before operation for using an OPC UA server module.

4.1 Starting an OPC UA Server Module and a Configuration Personal Computer

<table>
<thead>
<tr>
<th>Procedure</th>
<th>OPC UA server module*1</th>
<th>Configuration personal computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mount an OPC UA server module on a base unit.*2</td>
<td>Install the configuration tool.*3</td>
</tr>
<tr>
<td>2</td>
<td>Switch the dot matrix LED display mode switch to the right (SHOW).</td>
<td>---</td>
</tr>
<tr>
<td>3</td>
<td>Connect the OPC UA server module with the configuration personal computer on a 1:1 basis.*4</td>
<td>---</td>
</tr>
<tr>
<td>4</td>
<td>Turn the power of the system ON. (The ERR LED flashes because an SD memory card is not inserted.)</td>
<td>---</td>
</tr>
<tr>
<td>5</td>
<td>Insert an SD memory card.*5</td>
<td>---</td>
</tr>
<tr>
<td>6</td>
<td>---</td>
<td>Start the configuration tool.</td>
</tr>
<tr>
<td>7</td>
<td>---</td>
<td>Select &quot;Direct Connection&quot; in the &quot;Target Setting&quot; screen.*6</td>
</tr>
<tr>
<td>8</td>
<td>---</td>
<td>Format the SD memory card as necessary.</td>
</tr>
<tr>
<td>9</td>
<td>---</td>
<td>Configure the setting for the OPC UA server module.</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Write the setting to the OPC UA server module.</td>
</tr>
<tr>
<td>11</td>
<td>---</td>
<td>Update the setting of the OPC UA server module.</td>
</tr>
<tr>
<td>12</td>
<td>Connect the OPC UA server module and configuration personal computer to a network according to the network setting configured in the configuration tool.*7</td>
<td>---</td>
</tr>
<tr>
<td>13</td>
<td>Start the operation.</td>
<td></td>
</tr>
</tbody>
</table>

*1 Perform the self-diagnostic test as necessary. (MELSEC iQ-R OPC UA Server Module User’s Manual (Application))
*2 Do not use an electric screwdriver to attach and remove module fixing screws.
*3 Page 55 INSTALLATION AND UNINSTALLATION
*4 Page 48 System configuration for the initial setup, maintenance, and inspection
*5 Page 44 SD Memory Card
*6 Specify the following items (default security setting) for connection in the "Target Setting" screen of the configuration tool.
  ● Use the User Authentication: Select the checkbox.
  ● User Name: RD81OPC96
  ● Password: MITSUBISHI
*7 Page 37 Network setting for connection
Network setting for connection

The following shows the network setting for a configuration personal computer when connecting the computer to an OPC UA server module via a hub.

Operating procedure

1. Set the same value for the network portion of the IP addresses for a configuration personal computer and an OPC UA server module.

<table>
<thead>
<tr>
<th>Network part</th>
<th>Host part</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.3.</td>
<td>3</td>
</tr>
<tr>
<td>255.255.255.0</td>
<td>0</td>
</tr>
</tbody>
</table>

Default value of an OPC UA server module

<table>
<thead>
<tr>
<th>Network part</th>
<th>Host part</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.3.100</td>
<td>0</td>
</tr>
</tbody>
</table>

Configuration personal computer

Set different values.


(Example) Microsoft Windows 7 Ultimate

① Select [Control Panel] ⇒ [Network and Internet] ⇒ [Network and Sharing Center] ⇒ [Change adapter settings].
② Select and right-click [Local Area Connection], then select [Properties] from the shortcut menu.
③ Select "Internet Protocol Version 4 (TCP/IPv4)" on the "Local Area Connection Properties" screen, and click the [Property] button.

3. Restart the personal computer to enable the network setting.
4.2 Configuration Tool

This section shows the configuration tool to set the OPC UA server setting of an OPC UA server module.
For details on the configuration tool, refer to the following:
MELSEC iQ-R OPC UA Server Module User's Manual (Application)

### Startup method

#### Operating procedure

Select [MELSOFT] ⇒ [MX OPC UA]*2 ⇒ [MELSEC iQ-R series OPC UA Server Module Configuration Tool] from Windows Start*1.

*1 Select [All apps] in the Start screen or [Start] ⇒ [All Programs]/[All apps].

*2 Does not appear in Windows 8 or later.

### Display Language Switching

The configuration tool supports multiple languages, and therefore the display language such as one on the menu can be switched on a personal computer.

#### Window

[View] ⇒ [Switch Display Language]

![Switch Display Language](image)

#### Precautions

If the display language differs from the one for the operating system, texts may not displayed properly on the screen.
(Displayed texts may get cut.)
**Screen configuration**

(1) Menu bar
(2) Tree view
(3) List view
(4) Log view

**Menu configuration**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>To discard a project being edited and create a new project.</td>
</tr>
<tr>
<td>Open Project</td>
<td>To open a project file saved in a personal computer.</td>
</tr>
<tr>
<td>Save</td>
<td>To overwrite and save a project being edited in a file.</td>
</tr>
<tr>
<td>Save as</td>
<td>To name and save a project being edited.</td>
</tr>
<tr>
<td>Close</td>
<td>To close a project being edited.</td>
</tr>
<tr>
<td>(recently opened project)</td>
<td>To open a project file used recently in the configuration tool.</td>
</tr>
<tr>
<td>Exit</td>
<td>To end the configuration tool.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
</tr>
<tr>
<td>New Target Device</td>
<td>To add a new access target device.</td>
</tr>
<tr>
<td>New Group</td>
<td>To add a new group.</td>
</tr>
<tr>
<td>New Data Tag</td>
<td>To add a new tag.</td>
</tr>
<tr>
<td>New Structure Type Declarations</td>
<td>To add a new structure label.</td>
</tr>
<tr>
<td>New Conversion Definitions</td>
<td>To add a new conversion definition.</td>
</tr>
<tr>
<td>New Polling Method Definitions</td>
<td>To add a new polling definition.</td>
</tr>
<tr>
<td>New Structure Type Declarations</td>
<td>To add a new structure definition.</td>
</tr>
<tr>
<td>Cut</td>
<td>To cut a selected item and copy it to the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>To copy a selected item to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>To paste an item on the clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>To select all objects on the list.</td>
</tr>
<tr>
<td>Invert Selection</td>
<td>To switch items to be highlighted.</td>
</tr>
<tr>
<td>Delete</td>
<td>To delete a selected item.</td>
</tr>
<tr>
<td>Import Global Label</td>
<td>To import global labels as data from a project file in an engineering tool.</td>
</tr>
<tr>
<td>Release Relation to Global Label</td>
<td>To release the relation between data and an import source global label.</td>
</tr>
<tr>
<td>Update Data Related to Global Label</td>
<td>To update data to the latest value when a value in an import source global label is changed.</td>
</tr>
<tr>
<td>Import Common Device Comment</td>
<td>To import common device comments as data from a project file in an engineering tool.</td>
</tr>
<tr>
<td>Properties</td>
<td>To display the property of a selected item.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View</td>
<td>Basic Function Bar To show/hide the buttons for basic functions.</td>
</tr>
<tr>
<td></td>
<td>Online Operating Bar To show/hide the buttons for online operation.</td>
</tr>
<tr>
<td></td>
<td>Status Bar To show/hide the status bar.</td>
</tr>
<tr>
<td></td>
<td>Log To show/hide the log view.</td>
</tr>
<tr>
<td></td>
<td>Large Icons To change the icons on the list view to the large ones.</td>
</tr>
<tr>
<td></td>
<td>Small Icons To change the icons on the list view to the small ones.</td>
</tr>
<tr>
<td></td>
<td>List To display an item on the list view in a list.</td>
</tr>
<tr>
<td></td>
<td>Details To display an item on the list view in detail.</td>
</tr>
<tr>
<td></td>
<td>Sort To sort an item on the list view by specifying a row.</td>
</tr>
<tr>
<td></td>
<td>Row To select a row to display on the list view.</td>
</tr>
<tr>
<td></td>
<td>Switch Display Language To switch the display language.</td>
</tr>
<tr>
<td>Go</td>
<td>Back To go back to the previously selected item.</td>
</tr>
<tr>
<td></td>
<td>Forward To go back to the previously selected item.</td>
</tr>
<tr>
<td></td>
<td>To restore the operation of 'Back'.</td>
</tr>
<tr>
<td></td>
<td>Up One Level To move up one level in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Next Item To move to the next item in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Previous Item To move to the previous item in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Expand Item To expand a selected item in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Collapse Item To collapse a selected item in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Home To move to the top item in the tree view.</td>
</tr>
<tr>
<td></td>
<td>End To move to the bottom item in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Address Space To move to &quot;Address Space&quot; in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Conversion Definitions To move to &quot;Conversion Definitions&quot; in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Polling Method Definitions To move to &quot;Polling Method Definitions&quot; in the tree view.</td>
</tr>
<tr>
<td></td>
<td>Structure Type Declarations To move to &quot;Structure Type Declarations&quot; in the tree view.</td>
</tr>
<tr>
<td>Tool</td>
<td>Security Setting To set a user account for user authentication confirmed when accessing an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Network Setting To set the setting required for a network connection.</td>
</tr>
<tr>
<td></td>
<td>OPC UA Server Setting To set the setting related to an OPC UA server which operates on an OPC UA server module.</td>
</tr>
<tr>
<td>Online</td>
<td>Target Setting To set the setting to connect to an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Read from OPC UA Server Module To read the server setting from an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Write to OPC UA Server Module To write the server setting to an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Verify with OPC UA Server Module To verify the server setting in an OPC UA server module with that in the configuration tool.</td>
</tr>
<tr>
<td></td>
<td>Update setting of OPC UA Server Module To update a setting of an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Restart the OPC UA Server Module To restart a server operation of an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Stop the OPC UA Server Module To stop a server operation of an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>OPC UA Server Module Information To display the current connection status.</td>
</tr>
<tr>
<td></td>
<td>OPC UA Server Module Management To display information on an OPC UA server module and perform operations to it.</td>
</tr>
<tr>
<td></td>
<td>SD Memory Card Diagnosis To display the current use status of the SD memory card inserted in an OPC UA server module and format the SD memory card.</td>
</tr>
<tr>
<td></td>
<td>Manage Application Certificate To manage application certificates in an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Manage User Certificate To manage user certificates in an OPC UA server module.</td>
</tr>
<tr>
<td>Help</td>
<td>Help To open the user's manual of an OPC UA server module.</td>
</tr>
<tr>
<td></td>
<td>Version Information To display the version information of the configuration tool.</td>
</tr>
</tbody>
</table>

**Item** | **Description** |
---|---|
Basic Function Bar | To show/hide the buttons for basic functions. |
Online Operating Bar | To show/hide the buttons for online operation. |
Status Bar | To show/hide the status bar. |
Log | To show/hide the log view. |
Large Icons | To change the icons on the list view to the large ones. |
Small Icons | To change the icons on the list view to the small ones. |
List | To display an item on the list view in a list. |
Details | To display an item on the list view in detail. |
Sort | To sort an item on the list view by specifying a row. |
Row | To select a row to display on the list view. |
Switch Display Language | To switch the display language. |
Back | To go back to the previously selected item. |
Forward | To go back to the previously selected item. To restore the operation of 'Back'. |
Up One Level | To move up one level in the tree view. |
Next Item | To move to the next item in the tree view. |
Previous Item | To move to the previous item in the tree view. |
Expand Item | To expand a selected item in the tree view. |
Collapse Item | To collapse a selected item in the tree view. |
Home | To move to the top item in the tree view. |
End | To move to the bottom item in the tree view. |
Address Space | To move to "Address Space" in the tree view. |
Conversion Definitions | To move to "Conversion Definitions" in the tree view. |
Polling Method Definitions | To move to "Polling Method Definitions" in the tree view. |
Structure Type Declarations | To move to "Structure Type Declarations" in the tree view. |
Security Setting | To set a user account for user authentication confirmed when accessing an OPC UA server module. |
Network Setting | To set the setting required for a network connection. |
OPC UA Server Setting | To set the setting related to an OPC UA server which operates on an OPC UA server module. |
Target Setting | To set the setting to connect to an OPC UA server module. |
Read from OPC UA Server Module | To read the server setting from an OPC UA server module. |
Write to OPC UA Server Module | To write the server setting to an OPC UA server module. |
Verify with OPC UA Server Module | To verify the server setting in an OPC UA server module with that in the configuration tool. |
Update setting of OPC UA Server Module | To update a setting of an OPC UA server module. |
Restart the OPC UA Server Module | To restart a server operation of an OPC UA server module. |
Stop the OPC UA Server Module | To stop a server operation of an OPC UA server module. |
OPC UA Server Module Information | To display the current connection status. |
OPC UA Server Module Management | To display information on an OPC UA server module and perform operations to it. |
SD Memory Card Diagnosis | To display the current use status of the SD memory card inserted in an OPC UA server module and format the SD memory card. |
Manage Application Certificate | To manage application certificates in an OPC UA server module. |
Manage User Certificate | To manage user certificates in an OPC UA server module. |
Help | To open the user's manual of an OPC UA server module. |
Version Information | To display the version information of the configuration tool. |
Tree view
Address space information and each definition are displayed in a tree.
"Address Space" is displayed in red in the following cases:
• The number of tags exceeds the upper limit of the total number of words.
• The number of name characters exceeds the upper limit of the total number of characters.
The current total numbers of words and characters can be checked in the tooltip of "Address Space."
For each upper limit value, refer to the following:
Page 19 Operation specification

List view
A child item of an item selected in the tree view is displayed in a list.
Clicking the header of each column can sort items in ascending or descending order by comparing character strings.
Note that clicking the header of the "Device" column sorts items by comparing character strings of device names and numerical values of device numbers.

Log view
A communication event log between an OPC UA server module and the configuration tool is displayed (up to 500 logs).
If 500 or more events occur, an old log is deleted in chronological order.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time stamp</td>
<td>The date and time when an event occurred is displayed.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of an event is displayed.</td>
</tr>
<tr>
<td></td>
<td>• Information: Information message such as a communication parameter</td>
</tr>
<tr>
<td></td>
<td>• Warning: Warning level message</td>
</tr>
<tr>
<td></td>
<td>• Error: Error level message</td>
</tr>
<tr>
<td>Contents</td>
<td>The content of an event is displayed.</td>
</tr>
</tbody>
</table>
4.3 Parameter Setting

This section shows the mode setting of an OPC UA server module in the parameter setting of an engineering tool. For details on the parameter setting, refer to the following:

□ MELSEC iQ-R OPC UA Server Module User’s Manual (Application)

**Startup method**

**Operating procedure**

Select [MELSOFT] ⇒ [GX Works3] \(^2\) ⇒ [GX Works3] from Windows Start\(^1\).

\(^1\) Select [All apps] in the Start screen or [Start] ⇒ [All Programs]/[All apps].

\(^2\) Does not appear in Windows 8 or later.

**Parameter setting**

**Operating procedure**

1. Create a new project.

   ![Create a new project](image)

2. Select a series, a type, and a program language, click the [OK] button.

   ![Select a series, type, and program language](image)

3. Set whether to use module labels and sample comments, and click the [OK] button.

   ![Set module labels and sample comments](image)

4. Display the "Add New Module" screen.

   ![Add New Module](image)

   [Navigation window] ⇒ [Parameter] ⇒ [Module Information] ⇒ right-click ⇒ [Add New Module] in the shortcut menu
5. Add an OPC UA server module.

![Add New Module dialog box showing module selection and parameter settings.]

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Type</td>
<td>Select &quot;Information Module.&quot;</td>
</tr>
<tr>
<td>Module Name</td>
<td>Select &quot;RD81OPC96.&quot;</td>
</tr>
<tr>
<td>Mounting Slot No.</td>
<td>Select the slot number where an OPC UA server module is mounted.</td>
</tr>
<tr>
<td>Start I/O No. Specification</td>
<td>Select &quot;Not Set&quot; when not specifying the start I/O number of an OPC UA server module; otherwise, select &quot;Set.&quot;</td>
</tr>
<tr>
<td>Start I/O No.</td>
<td>When selecting &quot;Set&quot; for &quot;Start I/O No. Specification,&quot; enter the start I/O number of an OPC UA server module.</td>
</tr>
</tbody>
</table>

6. Set whether to use module labels and sample comments, and click the [OK] button.

![Setting module label and comments dialog box.]

7. Set the module parameters of an OPC UA server module.

   [Navigation window] ⇒ [Parameter] ⇒ [Module Information] ⇒ [RD81OPC96]

8. After setting the parameter, write the setting to a CPU module from an engineering tool.

9. Reset the CPU module or turn the power OFF and ON to apply the setting.
4.4 SD Memory Card

This section shows an SD memory card inserted and used in an OPC UA server module.
For supported SD memory cards and considerations, refer to the following:
Page 51 SD memory card (sold separately, required)
Page 47 Considerations for using an SD memory card

Operation for inserting an SD memory card

The following shows the procedure for inserting an SD memory card.

1. Insert an SD memory card. (Page 46 Insertion procedure)
2. Turn the power of a programmable controller ON if it is OFF.
3. Check if the SD memory card is securely inserted in the OPC UA server module. (It is properly inserted if the CARD RDY LED turns ON.)

Operation for removing or replacing an SD memory card

The following shows the procedures for removing and replacing an SD memory card. File access must be stopped.
If the power is OFF and the file access is not stopped, turn the power ON and stop the file access.

Removing an SD memory card

1. Turn the power of a programmable controller ON if it is OFF.
2. Stop file access, and disable reading from/writing to an SD memory card. (Page 45 File access stop processing method)
3. Remove the SD memory card. (Page 46 Removal procedure)

Replacing an SD memory card

1. Perform the operations for removing an SD memory card.
2. Insert a new SD memory card. (Page 46 Insertion procedure)
3. Perform any of the following operations:
   ● Update the setting.
   ● Turn the power OFF and ON.
   ● Reset a CPU module.

Point

- If an error occurs on an SD memory card, refer to the following:
  (MELSEC iQ-R OPC UA Server Module User's Manual (Application))
- The setting of an OPC UA server module is saved in an SD memory card. Therefore, if the CPU module is turned OFF to ON or reset when any SD memory card is inserted or any setting is not written to the SD memory card, the IP address of the OPC UA server module returns to the default (192.168.3.3).
As necessary, read the current setting before removing an SD memory card. Then, promptly write the setting to the new card after the replacement.
File access stop processing method

The following are the methods to stop file access.
- Using the switch on the front of a module
- Using the I/O (X/Y) signal

Method by using the switch on the front of a module
1. Press the SD memory card lock switch for one second or more.
2. Check that the CARD RDY LED is turned OFF.

Method by using the I/O (X/Y) signal
1. Turn 'File access stop request' (Y3) from OFF to ON.
2. Check that 'File access status' (X3) turns from OFF to ON, or the CARD RDY LED turns OFF.
3. Turn 'File access stop request' (Y3) ON to OFF.

<table>
<thead>
<tr>
<th>Y3</th>
<th>X3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(1) Accessing</td>
</tr>
<tr>
<td>(2) Stopped</td>
<td></td>
</tr>
</tbody>
</table>
Insertion/removal method of an SD memory card

Make sure to stop the file access when removing or replacing an SD memory card.

**Insertion procedure**

1. Insert an SD memory card (1) straight into the SD memory card slot with its cutout pointed down. Make sure it is not uplifted after inserting it. If it is inserted insufficiently, it may cause malfunction due to poor contact.

2. The CARD RDY LED (2) keeps flashing until the SD memory card is ready to be used. Once the CARD RDY LED(2) turns ON, the SD memory card can be used.

**Removal procedure**

1. Press the SD memory card lock switch (1) for one second or longer to stop the SD memory card access. (Page 45 File access stop processing method)

2. The CARD RDY LED (2) is flashing while stopping the file access, and it turns OFF once the processing is completed.

3. Push the SD memory card (3) in once, and pull it out straight.
Considerations for using an SD memory card

SD memory card to be used
Use a supported SD memory card. (Page 51 SD memory card (sold separately, required))
If another SD memory card is used, data in the SD memory card may be corrupted or the system may stop.
When using an SD memory card used for other uses, make sure to format the card with the SD memory card diagnostic on
the configuration tool. (MELSEC iQ-R OPC UA Server Module User's Manual (Application))

Turning the power OFF or resetting a CPU module
Data writing to an SD memory card may not be completed if the CPU module is turned OFF or reset during the writing.
Normally, the power supply can be turned OFF without stopping the file access since files are automatically repaired by the
OPC UA server module when powering ON again.
However, infrequently, a file cannot be repaired completely by performing the above operations.
In addition, do not power OFF or reset a CPU module while formatting the SD memory card.
If any problem arises, power OFF or reset the CPU module after stopping the file access.
Check that the SD memory card is not being formatted since it can be formatted while stopping the file access.
For the important data, create backups in other media periodically.

Removing or replacing an SD memory card
Make sure to stop the file access before removing or replacing an SD memory card. (If the power is OFF and the file access
is not stopped, turn the power ON and stop the file access.)
Otherwise, the data in the SD memory card being accessed may be corrupted or a file system failure may occur.
Check that the SD memory card is not being formatted since it can be formatted while stopping the file access.
The setting of OPC UA server module is saved in an SD memory card. Therefore, write the setting after the replacement as
necessary.

SD memory card format
An SD memory card can be formatted with the SD memory card diagnostic on the configuration tool. (MELSEC iQ-R OPC
UA Server Module User's Manual (Application))
Do not format an SD memory card with standard format commands of an operating system such as Windows.

Files in an SD memory card
Do not edit a file or folder in an SD memory card directly by inserting the card in a personal computer.
Make sure to use an SD memory card by inserting in an OPC UA server module.

SD memory card life
An SD memory card has a life (a limit on the number of times for writing data). For details, refer to the specification of an SD
memory card to use.
5 SYSTEM CONFIGURATION

This chapter shows the system configuration of an OPC UA server module.

5.1 System Configuration

Overall system configuration

The following figure shows the overall system configuration when using an OPC UA server module.

For initial setting, only Ethernet port (CH1) can be used.

For using the Ethernet port (CH2), set a network in the network setting in the configuration Tool.

MELSEC iQ-R OPC UA Server Module User's Manual (Application)
System configuration during operation

This section shows the system configuration when operating an OPC UA server module.

Connection via a hub

An OPC UA server module can be connected to a configuration personal computer via a hub in a local area network. The IP address of an OPC UA server module needs to be specified.

![Diagram of connection via a hub]

1. OPC UA server module
2. Ethernet (twisted pair cable)
3. Hub
4. OPC UA client
5. Configuration personal computer

Direct connection

An OPC UA server module can directly be connected to a configuration personal computer on a 1:1 basis with an Ethernet cable (crossover cable) without a hub. Communication can be established without specifying the IP address of an OPC UA server module. (Broadcast is used.)

![Diagram of direct connection]

1. OPC UA server module
2. Ethernet (twisted pair cable)
3. Configuration personal computer
Considerations for direct connection

■ Connecting to a LAN line
Do not perform communication by connecting to a LAN line directly.
This may increase the line load and affect the communications of other devices.

■ Connections which are not direct connections
Do not set the direct connection in a configuration where a single OPC UA server module is connected to a single configuration personal computer via a hub as shown in the following figure.

![Diagram](image)

(1) OPC UA server module
(2) Ethernet (twisted pair cable)
(3) Hub
(4) Configuration personal computer

■ Conditions where communication cannot be established directly
If the following condition is satisfied, communication by direct connection may not be established. In that case, review the settings of the OPC UA server module and configuration personal computer.
• When all bits of the IP address of an OPC UA server module that correspond to the '0' parts of a configuration personal computer subnet mask are ON or OFF

Ex
IP address of an OPC UA server module: 64.64.255.255
IP address of a Configuration personal computer: 64.64.1.1
Subnet mask on a configuration personal computer: 255.255.0.0
• When all bits of the IP address of an OPC UA server module that correspond to the host address for each class of the IP address of a configuration personal computer are ON or OFF

Ex
IP address of an OPC UA server module: 64.64.255.255
IP address of a Configuration personal computer: 192.168.0.1
Subnet mask on a configuration personal computer: 255.0.0.0

• The IP addresses of each class are as follows:
  Class A: 0.x.x.x to 127.x.x.x, Class B: 128.x.x.x to 191.x.x.x, Class C: 192.x.x.x to 223.x.x.x
• The host address for each class is the following '0' part.
  Class A: 255.0.0.0, Class B: 255.255.0.0, Class C: 255.255.255.0

■ Other considerations
● When the Windows firewall setting of a configuration personal computer is enabled
  Disable the Windows firewall setting.
● When multiple IP addresses are enabled in a configuration personal computer
  In the configuration where multiple IP addresses are enabled at the same time as shown below, do not set the setting for direct connection.
  • An IP address is assigned to each Ethernet port of the configuration personal computer with multiple Ethernet ports.
  • The wireless LAN setting is enabled in addition to the Ethernet port of a configuration personal computer.
  • Multiple IP addresses are assigned to one network device (Ethernet port) of a configuration personal computer.
5.2 Connection Device

This section shows the connectable devices to an OPC UA server module.

SD memory card (sold separately, required)

One SD memory card is required for using an OPC UA server module.

Use one of the following SD memory cards manufactured by Mitsubishi Electric.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NZ1MEM-2GBSD</td>
<td>2 GB</td>
</tr>
<tr>
<td>NZ1MEM-4GBSD</td>
<td>4 GB</td>
</tr>
<tr>
<td>NZ1MEM-8GBSD</td>
<td>8 GB</td>
</tr>
<tr>
<td>NZ1MEM-16GBSD</td>
<td>16 GB</td>
</tr>
</tbody>
</table>

For using an SD memory card, make sure to refer to the following section. (Page 47 Considerations for using an SD memory card)

Ethernet (twisted pair) cable (sold separately)

The Ethernet cables compliant with IEEE802.3 1000BASE-T/100BASE-TX/10BASE-T standards can be used.

<table>
<thead>
<tr>
<th>Transmission speed</th>
<th>Unshielded twisted pair cable (UTP cable)</th>
<th>Shielded twisted pair cable (STP cable)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Straight cable</td>
<td>Crossing cable</td>
</tr>
<tr>
<td>1 Gbps</td>
<td>Category 5e or higher</td>
<td>Category 5e</td>
</tr>
<tr>
<td>100 Mbps</td>
<td>Category 5 or higher</td>
<td>Category 5 or 5e</td>
</tr>
<tr>
<td>10 Mbps</td>
<td>Category 3 or higher</td>
<td>Category 3 to 5e</td>
</tr>
</tbody>
</table>

When using an Ethernet cable, make sure to refer to the considerations. (Page 54 Wiring Precautions)
5.3 Operating Environment

This section shows the operating environment of the configuration tool.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal computer</td>
<td>A personal computer on which Microsoft® Windows® operates</td>
</tr>
<tr>
<td>CPU</td>
<td>Intel® Core™ 2 Duo 2 GHz or more recommended</td>
</tr>
<tr>
<td>Required memory</td>
<td>64-bit OS: 2 GB or more recommended</td>
</tr>
<tr>
<td></td>
<td>32-bit OS: 1 GB or more recommended</td>
</tr>
<tr>
<td>Display</td>
<td>Resolution 1024 x 768 pixels or higher</td>
</tr>
<tr>
<td>Hard disk free space</td>
<td>512 MB or more</td>
</tr>
<tr>
<td>Disk drive</td>
<td>DVD-ROM disk drive</td>
</tr>
<tr>
<td>Interface</td>
<td>Ethernet(IPv4) 1000BASE-T/100BASE-TX/10BASE-T</td>
</tr>
<tr>
<td>Operating system (English version)</td>
<td>Windows 10 (Home, Pro, Enterprise, Education)³⁵</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1, Windows 8.1 (Pro, Enterprise)²⁷</td>
</tr>
<tr>
<td></td>
<td>Windows 8, Windows 8 (Pro, Enterprise)³⁷</td>
</tr>
<tr>
<td></td>
<td>Windows 7 SP1 (Home Premium, Professional, Ultimate, Enterprise)</td>
</tr>
</tbody>
</table>

*1 When the following functions are used, this product may not run properly.
  ● Application start-up in Windows compatibility mode
  ● Fast user switching
  ● Remote desktop
  ● Power save mode (standby, hibernate, sleep)
  ● Windows XP Mode
  ● Windows Touch or Touch
  ● Modern UI
  ● Client Hyper-V
  ● Virtual environment (VMware®, Windows Virtual PC)
  ● Tablet mode
  ● Virtual desktop

*2 In the following cases, the screen of this product may not work properly.
  ● The size of the text and other items in the screen is other than 100% (96 DPI, 9 pt etc.).
  ● The resolution of the screen is changed in operation.
  ● The multi-display is set.

*3 Use the product as a standard user or an administrator.

*4 When .NET Framework 4.0 and Visual C++® 2010 SP1 Redistributable Package (x86) are not installed on a personal computer on which the configuration tool is to be installed, approximately 500 MB of free space is required in the system drive to install them.

*5 When the Windows firewall setting is enabled, online functions may not work properly. In this case, disable the Windows firewall setting.

*6 When .NET Framework 4.6 Advanced Services® is disabled, it is required to be enabled.

*7 When .NET Framework 4.5 Advanced Services® is disabled, it is required to be enabled.

5.4 Supported Software Package

The following table shows the software package supporting an OPC UA server module.

<table>
<thead>
<tr>
<th>Software package</th>
<th>Software version</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX Works3</td>
<td>1.035M or later</td>
</tr>
</tbody>
</table>
6 WIRING

This section shows the method for connecting an Ethernet cable to an OPC UA server module.
For connectable Ethernet cables, refer to the following:
Page 51 Ethernet (twisted pair) cable (sold separately)

6.1 Wiring of an Ethernet Cable

The following shows the connection and disconnection methods of an Ethernet cable.

**Connection procedure**

1. Check the insertion direction, and insert an Ethernet cable into an Ethernet port of an OPC UA server module until it clicks.

2. Lightly pull the cable to check that it is securely connected.

3. Check the SPEED LED lighting status of the Ethernet port connected with the Ethernet cable. (Page 15 PART NAMES)

   - The time required from when an Ethernet cable is connected to when the SPEED LED turns ON may vary. Normally, it turns ON in a few seconds. However, it may take longer because the linking-up processing is repeated due to the device condition on the line.
   - When the SPEED LED does not turn ON, check if the connected Ethernet cable has any failure.
   - The SPEED LED turns OFF when connecting with an Ethernet device on the network the data transmission speed of which is 10 Mbps. Check the communication status by performing the ping test etc.

**Disconnection procedure**

Pull out the Ethernet cable while pinching the clip on the connector.

**Considerations for 1000BASE-T/100BASE-TX connection**

A communication error may occur due to the high frequency noise generated from a device other than a programmable controller depending on the installation environment.
The following shows the measures to be taken on the OPC UA server module side to prevent the influence of high frequency noise.

- Do not bundle a cable with the main circuit or power cable, or do not place it near those lines.
- Place a cable in a duct.
- In the environment where a cable is susceptible to noise, use the STP cable.
- Change a target device connected with an OPC UA server module to one which communicates at 10 Mbps, and decrease the data transmission speed.
6.2 Wiring Precautions

- To establish a reliable system and fully use the functions of a module, a wiring that does not easily receive the effects of noise is required.
- Sufficient safety measures must be taken when constructing the IEEE802.3 1000BASE-T/100BASE-TX/10BASE-T networks. Consult a specialist when handling the terminal processing of connection cable, installing trunk cables, etc.
- Use a cable compliant with IEEE802.3 1000BASE-T/100BASE-TX/10BASE-T standards. (Page 51 Ethernet (twisted pair) cable (sold separately))
- For the connection on the target device side, check the specifications of the target device in advance.
- Place an Ethernet cable in a duct or clamp it. Otherwise, the dangling cable may swing or inadvertently be pulled. It may cause a module or the cable to damage or malfunction due to poor contact.
- Protect the core wire in the connector of a cable or the port of a module to prevent touching by hand and sticking dirt or dust.
  - If any oil from your hand, dirt or dust sticks the core wire, it may increase the transmission loss and fail a data link.
- Check if an Ethernet cable used is disconnected, a short-circuit is generated, and the connector is properly connected.
- Do not use an Ethernet cable with a broken clip. Doing so may cause the unplugged cable or malfunction.
- Hold the connector of an Ethernet cable when connecting or disconnecting it. If the cable is pulled while being connected to a module, it may cause the module or Ethernet cable to damage or malfunction due to poor contact.
- Attach the provided connector cover to protect an unused Ethernet port from dirt and dust.
- The maximum segment length of an Ethernet cable is 100 m. However, the length may be shorter depending on the use environment of the cable. For details, contact the manufacturer of the cable used.
- The bend radius of an Ethernet cable is limited. For details, check the specifications of the Ethernet cable used.
7 INSTALLATION AND UNINSTALLATION

This chapter explains the procedures for installing and uninstalling MX OPC UA Module Configurator-R.

**Considerations for installation and uninstallation**

- Log on to a personal computer as a user with an administrator authority.
- Before installation, end all running applications on the operating system.
  - If software is installed while other applications are running, the product may not run normally.
- Install the software after changing the setting to prevent starting the update program automatically.
  - The installer may not run normally if an update program for either operating system or software of other companies such as Windows Update and Java® update may start automatically.
- After completing the installation, the computer may need to be restarted.
  - If the restart message appears, restart the computer before using it.

### 7.1 Installation Procedure

This section shows the installation procedure of MX OPC UA Module Configurator-R.

**Operating procedure**

1. **Start the installer.**
   - Double-click ‘setup.exe’ in the DVD-ROM with the MX OPC UA Module Configurator-R product.

2. **Enter or select the necessary information according to instructions shown on the screen.**

**Windows firewall setting**

When the firewall function of an operating system and security software are enabled, perform any of the following operations.

1. **Set the following programs to the firewall exception.**

   - MELSEC iQ-R series OPC UA Server Module Configuration Tool
     - Storage destination of an execution file (when the installation destination is C:\Program Files (x86)\MELSOFT.): C:\Program Files (x86)\MELSOFT\ROPCUA\MxOpcUaModuleConfiguratorR.exe

   *1 This setting is not required when the [Yes] button is selected on the screen below.

   ![Firewall Exception Setting](image)

   - To use this software, the registration to the exception list of Windows Firewall is needed. Are you sure you want to register?

   - Yes  No

   For the setting methods, refer to the manuals and online help of the operating system or security software used.

2. **Disable the firewall function.**
Setting to associate the extension (.mxcfg) of a project file and a program

When the [No] button is selected on the screen above, MX OPC UA Module Configurator-R does not open by double-clicking a project file with the extension (.mxcfg). Perform the following operation to open the file.

Operating procedure

[File] from the menu of MX OPC UA Module Configurator-R ⇒ [Open Project]

In another way, refer to the online help of an operating system and associate with a program.

Environment after installation

MX OPC UA Module Configurator-R is installed to a specified folder and registered in the start menu.
The following table shows the startup method and the maximum number of software, which can start at the same time, after installation.

<table>
<thead>
<tr>
<th>Software</th>
<th>Startup method</th>
<th>Maximum No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX OPC UA Module Configurator-R</td>
<td>Click [MELSOFT] ⇒ [MX OPC UA] ⇒ [MELSEC iQ-R series OPC UA Server Module Configuration Tool] from Windows Start</td>
<td>1</td>
</tr>
</tbody>
</table>

*1 Select [All apps] in the Start screen or [Start] ⇒ [All Programs]/[All apps].
*2 Does not appear in Windows 8 or later.

7.2 Uninstallation Procedure

This configuration tool can be uninstalled on the control panel in Windows.
Disable the Windows firewall if it was set manually.
For the method to disable the Windows firewall, refer to the manuals and online help of the operating system and the security software used.

Environment after uninstallation

An installed program file, folder, and start menu are deleted after the uninstallation.
However, if there is any file such as a project file output after the installation in a folder, the file/folder is not deleted.
This chapter shows the operation example of simple access in a system configuration including an OPC UA server module. The following example is for accessing the device (M0) of a CPU module from an OPC UA client.

### 8.1 Setup

#### System configuration

This section shows the setting for configuring a sample system including the following devices and software.

**Device/Software**

<table>
<thead>
<tr>
<th>Device/Software</th>
<th>Product name/description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Programmable</td>
<td>Main base unit R35B</td>
<td>MELSEC iQ-R Module Configuration Manual</td>
</tr>
<tr>
<td>controller system</td>
<td>Power supply module R61P</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CPU module R08CPU</td>
<td>Page 24 Accessible CPU modules</td>
</tr>
<tr>
<td></td>
<td>OPC UA server module RD81OPC96</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SD Memory Card NZ1MEM-(n)GBSD ((n) indicates a number of bytes.)</td>
<td>Page 51 SD memory card (sold separately, required)</td>
</tr>
<tr>
<td>(2) Twisted pair cable</td>
<td>A cable and a hub compliant with IEEE802.3 1000BASE-T/100BASE-TX/10BASE-T standards</td>
<td>Page 51 Ethernet (twisted pair) cable (sold separately)</td>
</tr>
<tr>
<td>and hub</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(3) Personal computer</td>
<td>A personal computer on which Windows 7 Professional Operating System (64-bit version)</td>
<td>Page 52 Operating Environment</td>
</tr>
<tr>
<td>OS</td>
<td>Microsoft Windows 7</td>
<td></td>
</tr>
<tr>
<td>Engineering tool</td>
<td>GX Works3</td>
<td>GX Works3 Installation Instructions GX Works3 Operating Manual</td>
</tr>
<tr>
<td></td>
<td>SWinDND-GXW3 ('(n)' indicates its version.)</td>
<td></td>
</tr>
<tr>
<td>Configuration tool</td>
<td>MX OPC UA Module Configurator-R</td>
<td>Page 55 INSTALLATION AND UNINSTALLATION</td>
</tr>
<tr>
<td></td>
<td>SW1DND-ROPBCU-E</td>
<td></td>
</tr>
</tbody>
</table>

- The IP address of an OPC UA server module is '192.168.3.3'.
- The IP address of a personal computer is '192.168.3.100'.

**Point**

To set a setting of an CPU module, connect a personal computer and the CPU module with a USB cable.
Device setup

This section shows the setup procedures of devices.

Personal computer setting

Operating procedure

1. Install MX OPC UA Module Configurator-R.
2. Set the IP address of a personal computer to '192.168.3.100'.
   This setting can be set on the "Internet Protocol Version 4 (TCP/IPv4) Properties" screen.

![Internet Protocol Version 4 (TCP/IPv4) Properties](image)

Programmable controller system setting

Operating procedure

1. Mount a power supply module, CPU module, and OPC UA server module on a main base unit.
   MELSEC iQ-R Module Configuration Manual
2. Insert an SD memory card into the OPC UA server module.
   Page 46 Insertion/removal method of an SD memory card
3. Set parameters and write them to the CPU module in the engineering tool.
   Page 42 Parameter Setting

For details on the parameter setting and programming in the engineering tool, refer to the following:
GX Works3 Operating Manual
8.2 Setting of an OPC UA Server Module

This section shows the setting of an OPC UA server module in the configuration tool.

Setting procedure

Starting the configuration tool
1. Start the configuration tool.
   Select [Start] ⇒ [All Programs] ⇒ [MELSOFT] ⇒ [MX OPC UA] ⇒ [MELSEC iQ-R series OPC UA Server Module Configuration Tool] from Windows Start.

Setting a network
1. Select [Tool] ⇒ [Network Setting].
   This setting is used as a default.

Setting an OPC UA server
1. Select [Tool] ⇒ [OPC UA Setting].
   - This setting is used as a default.
   - When connecting from an OPC UA client, use this setting.
Setting the security

1. Select [Tool] ⇒ [Security Setting].

   **Point**
   This setting is used as a default.

Setting an access target device under the address space

1. Select "Address Space" in the tree view.
2. Select [Edit] ⇒ [New Target Device].
3. Click the [OK] button.
1. Select "Dev000" under "Address Space" in the tree view.
2. Select [Edit] ⇒ [New Data Tag].
3. Click the [OK] button.
### Setting a connection destination

1. Select [Online] ⇒ [Target Setting].
2. Enter a user name and a password, then click the [OK] button.

The following are set by default.
- User name: RD81OPC96
- Password: MITSUBISHI

### Uploading a certificate to the trust list

1. Select [Online] ⇒ [Manage Application Certificate].
2. Upload a client certificate to the trust list.

For the procedure, refer to the following:
- MELSEC iQ-R OPC UA Server Module User’s Manual (Application)
8.3 Operation Check

This section shows the procedure to check whether an OPC UA client can access an OPC UA server.

1. Search an OPC UA server module from an OPC UA client, and connect the module.
2. Check whether the device (M0) of the CPU module can be read and written.

For the operation methods of an OPC UA client, refer to the manual of an OPC UA client to use.

For MC Works64, add ‘ua:’ at the beginning of the endpoint URL of an OPC UA server module.

(Example) ua:opc.tcp://192.168.3.3:4840
Appendix 1  External Dimensions

The following figures show the external dimensions of an OPC UA server module.

(Unit: mm)
## INDEX

<table>
<thead>
<tr>
<th>Section</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
</tr>
<tr>
<td>Access specifications</td>
<td>24</td>
</tr>
<tr>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Connection device</td>
<td>51</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Direct connection</td>
<td>50</td>
</tr>
<tr>
<td>Display language switching</td>
<td>38</td>
</tr>
<tr>
<td>Dot matrix LED</td>
<td>15</td>
</tr>
<tr>
<td>Dot matrix LED display mode switch</td>
<td>16</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Ethernet (twisted pair) cable</td>
<td>51</td>
</tr>
<tr>
<td>External dimension</td>
<td>64</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Function list</td>
<td>34,35</td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Insertion/removal method of an SD memory card</td>
<td>46</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Parameter setting</td>
<td>42</td>
</tr>
<tr>
<td>Performance specifications</td>
<td>17</td>
</tr>
<tr>
<td>Procedure before operation</td>
<td>36</td>
</tr>
<tr>
<td>S</td>
<td></td>
</tr>
<tr>
<td>SD memory card</td>
<td>44,51</td>
</tr>
<tr>
<td>SD memory card format</td>
<td>47</td>
</tr>
</tbody>
</table>
**REVISIONS**

*The manual number is given on the bottom left of the back cover.*

<table>
<thead>
<tr>
<th>Revision date</th>
<th><em>Manual number</em></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 2017</td>
<td>SH(NA)-081693ENG-A</td>
<td>First edition</td>
</tr>
<tr>
<td>October 2017</td>
<td>SH(NA)-081693ENG-B</td>
<td>□ Added or modified part Section 2.2</td>
</tr>
<tr>
<td>December 2018</td>
<td>SH(NA)-081693ENG-C</td>
<td>□ Added or modified parts TERMS, Section 2.1, Section 3.1, Section 3.2, Section 4.2, Section 8.2</td>
</tr>
<tr>
<td>February 2019</td>
<td>SH(NA)-081693ENG-D</td>
<td>Partial correction</td>
</tr>
<tr>
<td>May 2019</td>
<td>SH(NA)-081693ENG-E</td>
<td>□ Added or modified part Section 2.1</td>
</tr>
<tr>
<td>April 2020</td>
<td>SH(NA)-081693ENG-F</td>
<td>□ Added or modified parts Section 3.1, Section 3.2, Section 4.2</td>
</tr>
<tr>
<td>July 2021</td>
<td>SH(NA)-081693ENG-G</td>
<td>□ Added or modified parts SAFETY PRECAUTIONS, CONDITIONS OF USE FOR THE PRODUCT, Section 2.1, Section 2.2, Section 3.1, Section 3.2, Section 4.2, Section 8.2</td>
</tr>
</tbody>
</table>

Japanese manual number: SH-081691-G

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 2017 MITSUBISHI ELECTRIC CORPORATION
WARRANTY

Please confirm the following product warranty details before using this product.

1. Gratis Warranty Term and Gratis Warranty Range
   If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty term, the product shall be repaired at no cost via the sales representative or Mitsubishi Service Company.
   However, if repairs are required onsite at domestic or overseas location, expenses to send an engineer will be solely at the customer's discretion. Mitsubishi shall not be held responsible for any re-commissioning, maintenance, or testing on-site that involves replacement of the failed module.
   [Gratis Warranty Term]
   The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated place.
   Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.
   [Gratis Warranty Range]
   (1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.
   (2) Even within the gratis warranty term, repairs shall be charged for in the following cases.
       1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's hardware or software design.
       2. Failure caused by unapproved modifications, etc., to the product by the user.
       3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary by industry standards, had been provided.
       4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the instruction manual had been correctly serviced or replaced.
       5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as earthquakes, lightning, wind and water damage.
       6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.
       7. Any other failure found not to be the responsibility of Mitsubishi or that admitted not to be so by the user.

2. Onerous repair term after discontinuation of production
   (1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued.
   Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
   (2) Product supply (including repair parts) is not available after production is discontinued.

3. Overseas service
   Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA Center may differ.

4. Exclusion of loss in opportunity and secondary loss from warranty liability
   Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to:
   (1) Damages caused by any cause found not to be the responsibility of Mitsubishi.
   (2) Loss in opportunity, lost profits incurred to the user by Failures of Mitsubishi products.
   (3) Special damages and secondary damages whether foreseeable or not, compensation for accidents, and compensation for damages to products other than Mitsubishi products.
   (4) Replacement by the user, maintenance of on-site equipment, start-up test run and other tasks.

5. Changes in product specifications
   The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.
TRADEMARKS

Intel is either a registered trademark or a trademark of Intel Corporation in the United States and/or other countries.
Microsoft, Visual C++, and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Oracle and Java are registered trademarks of Oracle and/or its affiliates.
The company names, system names and product names mentioned in this manual are either registered trademarks or trademarks of their respective companies.
In some cases, trademark symbols such as "™" or "®" are not specified in this manual.
Specifications subject to change without notice.